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ΠΡΟΛΟΓΟΣ 

 
    Σκοπός της παρούσης διπλωµατικής εργασίας είναι η προετοιµασία του 
λεπτοµερούς τρισδιάστατου γεωµετρικού οµοιόµορφου (¨µοντελοποίηση¨) της 
Αθηναϊκής Τριήρους. 
    Η πρώτη επαφή µε τις ναυπηγικές γραµµές της Τριήρους και η χρήση αυτών έγινε 
στα πλαίσια του µαθήµατος ¨Συστήµατα CAD/CAM για την Σχεδίαση & Κατασκευή 
πλοίων¨ του 6ου εξαµήνου όπου και προσοµοιώθηκε το γεωµετρικό σχήµα της 
γάστρας της Τριήρους µε χρήση του σχεδιαστικού προγράµµατος ¨RHINOCHEROS 
3¨. Η σχεδίαση βασίστηκε στις ναυπηγικές γραµµές του συγγράµατος “ THE 
ATHENIAN TRIREME “  των J. S. MORRISON, J. F. COATES και N. B. 
RANKOV. 
    Στη συνέχεια, και  µε αφορµή το µάθηµα επιλογής του 9ου εξαµήνου του τµήµατος 
Ναυπηγών Μηχανολόγων Μηχανικών του Ε.Μ.Π ¨Σχεδίαση µε την βοήθεια 
υπολογιστή¨, όπου χρησιµοποιήσαµε το σχεδιαστικό πρόγραµµα CAD : CATIA V5, 
προέκυψε η ιδέα της προετοιµασίας του λεπτοµερούς γεωµετρικού µοντέλου της 
Αθηναϊκής Τριήρους και επελέγη ως θέµα της διπλωµατικής µου εργασίας. Το 
σύστηµα CAD CATIA V5 παρέχει την δυνατότητα πολλών µεθόδων (εργαλείων) 
σχεδίασης, γεγονός που µας ώθησε στη προσπάθεια να  χρησιµοποιήσουµε το 
συγκεκριµένο σύστηµα για να απεικονίσουµε µε λεπτοµέρεια τόσο τις  βασικές 
γραµµές όσο και τις κατασκευαστικές λεπτοµέρειες της Αθηναϊκής Τριήρους. 
     Τέλος µια ακριβής τρισδιάστατη γεωµετρική απεικόνιση της Τριήρους θα ήταν 
αρκετά χρήσιµη σε προγράµµατα εικονικής πραγµατικότητας στα οποία υπάρχει η 
δυνατότητα προσοµοίωσης του θαλασσίου περιβάλλοντος/κυµατισµού, καθώς  και  
της κίνησης του σκάφους, των κωπηλατών και των κουπιών. 
 
      Η συγγραφή της παρούσης διπλωµατικής εργασίας σηµατοδοτεί την αποφοιτησή 
µου από την σχολή Ναυπηγών Μηχανολόγων Μηχανικών του Ε.Μ.Π, και βρίσκοµαι 
αυτή τη στιγµή στην ευχάριστη θέση να εκφράσω τις ευχαριστίες µου προς όλους 
αυτούς που µου προσέφεραν την αµέριστη και τόσο σηµαντική βοηθειά τους. 
Ιδιαιτέρως θα ήθελα να ευχαριστήσω τον Επίκουρο Καθηγητή κ. Α. Γκίνη, αφού 
χωρίς την βοήθεια και συµβουλή του οποίου θα ήταν αδύνατη η περάτωση της 
εργασίας. Επίσης,θα ήθελα να ευχαριστήσω τον Καθηγητή κ. Π. Κακλή και τον 
Επίκουρο Καθηγητή κ. Γ. Ζαραφωνίτη για την βοήθειά τους ως διδάσκοντες και µέλη 
της εξεταστικής επιτροπής για την αποπεράτωση της διπλωµατικής µου εργασίας. 
Επίσης ευχαριστώ όλους τους φίλους συναδέλφους µου για την άψογη συνεργασία 
που είχαµε όλα αυτά τα χρόνια. Τέλος θα ήθελα να ευχαριστήσω τους γονείς µου για 
την βοήθεια και συµπαράσταση που µου προσέφεραν κατά την εκπόνηση  αυτής της 
διπλωµατικής εργασίας και να τους την αφιερώσω. 
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1. ΕΙΣΑΓΩΓΗ 

 
 

1.1 ΙΣΤΟΡΙΚΗ ΑΝΑ∆ΡΟΜΗ.. 
 

 
1.1.1 Η αρχαία τριήρης και η εξελιξή της 
 
Η αρχαία τριήρης ήταν η ναυπηγική εξέλιξη της διήρους που ήταν πολεµικό πλοίο µε 
δύο σειρές κουπιών και στην συνέχεια έγιναν τρείς. Ως πρώτος ναυπηγός που 
ναυπήγησε τριήρεις αναφέρεται απο τον Θουκυδίδη  ο περίφηµος Κορίνθιος 
ναυπηγός Αµεινοκλής, ο οποίος το έτος 704 π.Χ ναυπήγησε για λογαριασµό των 
Σαµίων τέσσερις τριήρεις. 
       Ναυτικοί ερευνητές και αρχαιολόγοι, ύστερα απο πολλές έρευνες και µελέτες, 
κατέληξαν στο συµπέρασµα ότι γενικά η κατάληξη –ηρης σε ένα πλοίο αναφερόταν 
στον αριθµό των σειρών των κωπηλατών ανά πλευρά (διήρης,τριήρης,τετρήρης). 
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1.1.2 Το πλήρωµα της τριήρους 
 
   Η τριήρης όπως φαίνεται και από το ονοµά της έφερε τρείς σειρές κωπηλατών οι 
οποίοι ανάλογα µε την θέση τους στο ύψος του πλοίου είχαν και τρεις διαφορετικές 
ονοµασίες : θρανίτες, ζυγίτες και θαλαµίτες. Οι θρανίτες κάθονταν σε θρόνους 
εξωτερικά της γάστρας, οι ζυγίτες στους ζυγούς του σκάφους του κυρίως 
καταστρώµατος και οι θαλαµίτες στο ύψος του θαλάµου(καµπίνα) του τριήραρχου 
στο χαµηλότερο κατάστρωµα εσωτερικά της γάστρας του πλοίου. 

 
 

 
 
 
Από υπάρχουσες πηγές (Ηρόδοτος, Θουκυδίδης, ∆ηµοσθένης, κ.ά) προκύπτει ότι 
συµφωνούν ότι το πλήρωµα της τριήρους ήταν 200 άνδρες οι οποίοι κατανέµονταν 
όπως παρακάτω : 7 αξιωµατικοί, 10 ναύτες γενικών καθηκόντων, 170 ερέτες 
(κωπηλάτες), 10 οπλίτες-ακοντιστές, 4 τοξότες. 
   Πρέπει να σηµειωθεί οτι οι κωπηλάτες ήταν κανονικοί πολίτες και όχι δούλοι ή 
κατάδικοι. Αν υπήρχε η ανάγκη απασχόλησης δούλων ή καταδίκων, τότε αυτοί 
έπρεπε πρώτα να απελευθερωθούν. Επίσης δεν ήταν δεµένοι στις θέσεις τους και 
ήταν συνήθως οπλισµένοι, ιδίως οι θρανίτες οι οποίοι έπαιρναν µέρος στη µάχη 
καταστρώµατος σε περίπτωση επιθέσεως σε εχθρικό πλοίο (ρεσάλτο). Ποτέ στην 
αρχαία Ελλάδα δεν χρησιµοποιήθηκαν τριήρεις για καταναγκαστικά έργα καταδίκων, 
όπως για παράδειγµα γινόταν στις Ρωµαϊκές τριήρεις και άλλες γαλέρες. 
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1.1.3 Η κίνηση της τριήρους 
  
  Η τριήρης µπορούσε να κινηθεί µε τα πανιά που υπήρχαν στα ιστία της, την 
κωπηλασία ή και µε συνδυασµό των παραπάνω, ανάλογα µε τις ανάγκες. 
   Ως πολεµικό πλοίο ήταν κατασκευασµένη να έχει ως κύριο µέσο πρόωσης τα 
κουπιά και σαν βοηθητικό τα ιστία µε τα πανιά.Τα πανιά, κατά κανόνα ήταν 
τετράγωνα ή  τραπεζοειδή και το µεγαλύτερο φέρονταν στο µεγάλο ιστό (κατάρτι) 
που ήταν στο µέσο του σκάφους, ενώ το µικρότερο φέρονταν σε κεκλιµένο ιστό 
πρώραθεν του µεγάλου (κυρίου) που ονοµαζόταν ακάτιος.Τα πανιά τα 
χρησιµοποιούσαν µόνο εφόσον έπνεαν ούριοι άνεµοι, δηλαδή άνεµοι προς την 
κατεύθυνση που επιθυµούσαν να κινηθούν. Ήταν δε τελείως ακατάλληλα για πλεύση 
σε πλαγιοδροµία. 
 
 
1.1.4 Η τριήρης και ο πολεµικός της ρόλος 
 
    Οι τριήρεις ήταν πολεµικά πλοία, και τα χρησιµοποιούσαν οι αρχαίοι για να 
µάχονται και εξουδετερώνουν  εχθρικές ναυτικές µονάδες. Τις  Τριήρεις αυτές τις 
χρησιµοποιούσαν πολλές µαζί, οργανωµένες σε µοίρες και στόλους. 
     Η πιο απλή και συνηθισµένη αποστολή τους ήταν να περιπολούν κατά µήκος των 
ακτών της κρατικής οντότητας που αποκαλούσαν πατρίδα και να αποτρέπουν 
εχθρικές ενέργειες κατά µήκος των ακτών αυτών και των φίλιων εµπορικών και 
αλιευτικών σκαφών. 
      Επίσης µπορούσαν να αναλάβουν το ρόλο των επιδροµικών κατά της εχθρικής 
ακτής, καταδιώκοντας ή και καταβυθίζοντας τα εχθρικά εµπορικά σκάφη και 
αποβιβάζοντας αγήµατα επιδροµών στην ξηρά. Το µικρό βύθισµα έκανε την τριήρη 
ικανή να πλέει σχεδόν µέχρι την εχθρική ακτή, ευνοώντας την αποβίβαση των 
επιδροµικών αγηµάτων. 
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2. ΓΕΩΜΕΤΡΙΚΑ & ΚΑΤΑΣΚΕΥΑΣΤΙΚΑ 

ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ ΣΤΟΙΧΕΙΑ ΤΗΣ ΤΡΙΗΡΟΥΣ 
 

2.1 ΚΥΡΙΕΣ ∆ΙΑΣΤΑΣΕΙΣ-ΓΕΝΙΚΑ ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ 
ΤΟΥ ΣΚΑΦΟΥΣ 

 
2.1.1 Κύριες διαστάσεις 
 
  Η τριήρης ήταν ένα πλοίο µακρόστενο, ταχύ, χαµηλό, µε ρηχή καρίνα και γενικά 
σχετικά ελαφριά και απλή συνολική κατασκευή. 

 
 

 
 
 
 Το µήκος της ήταν περίπου 33-43 µέτρα, το πλάτος της 5.0-6.0 µέτρα, το ύψος της 
2.1-2.5 µέτρα πάνω από την ίσαλο γραµµή και το βυθισµά της 0.9-1 µέτρα. 
   Υπολογίζεται ότι το βάρος της τριήρους µαζί µε το πλήρωµα ήταν 50 τόνοι και 
άλλο τοσο περίπου το βάρος του έρµατος που βοηθόυσε στην ισορροπία του πλοίου 
δηλαδή συνολικά 100 τόνοι. 
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2.1.2 Γενικά χαρακτηριστικά του σκάφους 
  
 Το µικρό βύθισµα και βάρος του σκάφους, του επέτρεπε να κινείται µε µέγιστη 
ταχύτητα που έφτανε περίπου τους 8 κόµβους µόνο µε τα κουπιά και τους 10 
κόµβους µε χρήση και των πανιών σε ούριο άνεµο. Μπορούσε να καλύψει απόσταση 
100 χιλιοµέτρων ηµερησίως. Επίσης µπορούσε να κινείται µε άνεση σε αβαθή νερά 
ενώ παράλληλα µπορούσαν να το τραβούν κάθε βράδυ στην ξηρά. 
   Αξιοσηµείωτο είναι οτι µπορούσε να διαλυθεί χωρίς να βυθιστεί. Αυτός είναι και ο 
λόγος που δεν έχουν βρεθεί ολόκληρα ναυάγια τριηρών. Το µεγαλύτερο µέρος ακόµη 
και των εµβολισµένων τριηρών παρέµενε στην επιφάνεια, έστω και ως συντρίµια. 
   Οι τριήρεις δεν ήταν ασφαλή πλοία στην κακοκαιρία, γιατί ήταν ρηχά και άρα 
ασταθή. Είχαν σχετικά µικρή αποθηκευτική χωρητικότητα για εφόδια µακρινού 
ταξιδιού και για αυτό συνοδεύονταν απο άλλα εµπορικά πλοία που όµως ήταν 
ευάλωτα σε εµβολισµούς. 
  Χαρακτηριστικές ήταν οι λεπτοµέρειες των τριηρών που είχαν τόσο στην πλώρη 
όσο και στην πρύµνη τους. 
   Στην πλώρη ήταν ζωγραφισµένο ένα µάτι, µε συµβολική σηµασία. Πρόσεχε την 
πορεία και αποµάκρυνε τα κακά πνεύµατα που θα µπορούσαν να βάλουν σε κίνδυνο 
το ταξίδι, ενώ λίγο πιο µπροστά µπρούντζινο έµβολο προεξείχε του πρόσθιου 
τµήµατος προς ενίσχυση της πλώρης. Χρησίµευε για να προκαλεί ρήγµατα στα 
εχθρικά σκάφη στις ναυµαχίες, ρήγµατα που συνήθως ήταν µοιραία. 
  Η πρύµνη τελείωνε στο ακροστόλιο, διακοσµητικό στοιχείο µε 4 ή 5 κυρτούς 
άξονες, σαν βεντάλια. Οι αρχαίοι ήθελαν το πλοίο να µοιάζει µε θαλάσσιο τέρας. Το 
ακροστόλιο ήταν η ουρά του τέρατος που έβγαινε από την θάλασσα.     
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2.2 ΑΝΑΦΟΡΑ ΣΤΑ ΥΛΙΚΑ/ΤΡΟΠΟ ΚΑΤΑΣΚΕΥΗΣ 

 
2.2.1 Υλικά κατασκευής 

 
Το σκάφος της τριήρους ήταν φτιαχµένο από ξύλο ελάτου/πεύκου, ώστε το πλοίο να 
είναι ελαφρύ. Η καρίνα όµως, το δοκάρι που φτάνει από την πλώρη στην πρύµνη, η 
σπονδυλική στήλη του πλοίου, ήταν από βελανιδιά (δρύς) για να είναι πιο ανθεκτική. 
 
 

 
 
 
Τα σχοινιά που κινούσαν το κατάρτι ήταν κατασκευασµένα από κάνναβη ή πάπυρο 
και αλειµµένα µε πίσσα, για να µη σαπίζουν εύκολα, ενώ κοµµάτια από δέρµα 
εξασφάλιζαν τη στεγανότητα στα διάφορα τµήµατα του πλοίου. 
   Τέλος το έµβολο που χρησιµοποιούσαν οι τριήρεις για να προκαλέσουν ρήγµατα 
στα εχθρικά σκάφη ήταν απο µπρούντζο. 
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2.2.2 Τρόπος κατασκευής 
 
Στην αρχαία Αθήνα ο ναυπηγός (αρχιτέκτων) που εκλεγόταν, δεν ήταν απαραίτητα 
ειδικός των σχετικών ναυπηγικών γνώσεων, µπορεί να ήταν και εξειδικευµένος 
εργολάβος. Οι συγκεκριµένοι εργολάβοι συνήθως ασχολούνταν παράλληλα και µε το 
εµπόριο ξυλείας. Η τεχνική της ναυπήγησης γενικά πήγαινε από πατέρα σε γιο, βάση 
παράδοσης, όχι όµως µε απόλυτο τρόπο.  Όλη η εργασία κατασκευής γινόταν σε 
απλό ναυπηγείο σε κάποια παραλία µε την τρόπιδα φυτεµένη στην άµµο και ξύλινες 
στηρίξεις. Συνήθως τα πλοία κατασκευάζονταν µε όσο το δυνατόν περισσότερα 
όµοια εξαρτήµατα, ώστε να επιτυγχάνεται οικονοµία κλίµακας, για µείωση του 
κόστους κατασκευής. Στο µόνο σηµείο που ο ναυπηγός είχε δικαίωµα να 
αυτοσχεδιάσει σε συµφωνία όµως µε τον τριήραρχο (που συνήθως χορηγούσε το 
ποσό για την κατασκευή του πλοίου) ήταν η διακόσµηση του εµβόλου και του 
υπόλοιπου πλοίου. 
    Ο σκελετός των τριηρών κατασκευαζόταν από ελατοσανίδες ή πευκοσανίδες. Η 
καρίνα και οι εγκάρσιες και διαµήκεις ενισχύσεις (νεύρα) ήταν δρύινα. Τα ξύλινα 
µέρη του σκελετού συνδέοταν (µατίζονταν) µε σφήνες. Οι ενώσεις αυτές ενισχύονταν 
µε καβίλιες. Στο κεντρικό δοκάρι της καρίνας καρφώνονταν τα κάτω εγκάρσια 
ενισχυτικά, ακολουθούσε η επένδυση της γάστρας, στην συνέχεια έµπαιναν τα 
µεσαία εγκάρσια ενισχυτικά, πάλι επενδυόταν το σκάφος έως το ύψος που έφταναν 
τα µεσαία ενισχυτικά, στη συνέχεια τα άνω εγκάρσια ενισχυτικά,κ.ο.κ. 
 

  
 
Το χτίσιµο της γάστρας γινόταν σταδιακά και εναλλάξ, σε διαφοροποίηση από τον 
παραδοσιακό σηµερινό τρόπο ναυπήγησης ξύλινων σκαφών που γίνονται πρώτα η 
καρίνα, µετά οι νοµείς ολόκληροι και τελος η επένδυση του σκάφους. 
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2.3 ΝΑΥΠΗΓΙΚΕΣ ΓΡΑΜΜΕΣ ΣΧΕ∆ΙΑΣΗΣ & 
ΚΑΤΑΣΚΕΥΑΣΤΙΚΑ ΣΧΕ∆ΙΑ ΤΗΣ ΤΡΙΗΡΟΥΣ 

 
 
       Σε αυτό το κεφάλαιο παρατίθενται οι ναυπηγικές γραµµές σχεδίασης καθώς και 
τα κατασκευαστικά σχέδια της Τριήρους. Αυτά περιλαµβάνουν, σχέδια εγκαρσίων 
τοµών ( Body Plan) και διαµηκών τοµών ( Half Breadth Plan). Επίσης τα σχέδια 
γενικής διάταξης (General Arrangement Plan) και µέσης τοµής (Midship Section 
Plan) της Τριήρους. Τέλος κατασκευαστικά σχέδια του σκάφους από τα οποία 
αντλούµε πρόσθετες πληροφορίες για την σχεδίαση ( κατασκευαστικά σχέδια 
γάστρας, κουπίών και αποστάσεως των ζυγών).  
       Όλες οι γραµµές προήλθαν από το σύγγραµα “ THE ATHENIAN TRIREME “ 
των ιστορικών / ναυπηγών J.S.MORRISON, J.F.COATES και N.B.RANKOV. 
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2.3.1 ΝΑΥΠΗΓΙΚΕΣ ΓΡΑΜΜΕΣ 
 
 

 
 
Αυτές είναι οι ναυπηγικές γραµµές που χρησιµοποιήθηκαν για την βασική σχεδίαση 
της τριήρους, σύµφωνα µε τους ιστορικούς / ναυπηγούς :  J.S.MORRISON, 
J.F.COATES and N.B.RANKOV. 
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2.3.2 ΣΧΕ∆ΙΟ ΓΕΝΙΚΗΣ ∆ΙΑΤΑΞΗΣ 
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2.3.3 ΣΧΕ∆ΙΟ ΜΕΣΗΣ ΤΟΜΗΣ 
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2.3.4  ΚΑΤΑΣΚΕΥΑΣΤΙΚΟ ΣΧΕ∆ΙΟ ΓΑΣΤΡΑΣ 
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2.3.5 ΚΑΤΑΣΚΕΥΑΣΤΙΚΟ ΣΧΕ∆ΙΟ ΤΩΝ 
ΚΟΥΠΙΩΝ 
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2.3.6 ΚΑΤΑΣΚΕΥΑΣΤΙΚΟ ΣΧΕ∆ΙΟ ΑΠΟΣΤΑΣΗΣ 
ΤΩΝ ΖΥΓΩΝ ΤΗΣ ΤΡΙΗΡΟΥΣ 
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3. ΚΑΤΑΣΚΕΥΗ ΤΡΙΣ∆ΙΑΣΤΑΤΟΥ 
ΛΕΠΤΟΜΕΡΟΥΣ ΓΕΩΜΕΤΡΙΚΟΥ ΜΟΝΤΕΛΟΥ 

ΤΡΙΗΡΟΥΣ 
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3.1 ΣΧΕ∆ΙΑΣΗ & ΕΞΟΜΑΛΥΝΣΗ ΤΩΝ ΒΑΣΙΚΩΝ 
ΓΡΑΜΜΩΝ ΤΗΣ ΤΡΙΗΡΟΥΣ ΜΕ ΧΡΗΣΗ ΤΟΥ 
ΣΥΣΤΗΜΑΤΟΣ CAD : RHINOCEROS 3 
 
Στο κεφάλαιο αυτό θα γίνει η σχεδίαση και η εξοµάλυνση των βασικών ναυπηγικών 
γραµµών της Τριήρους µε χρήση του συστήµατος  CAD / Rhinoceros 3. 
  
Στο σηµείο αυτό κρίνεται αναγκαίο να εξηγήσουµε το τρόπο κωδικοποίησης, των 
διαφόρων κεφαλαίων / υποκεφαλαίων / βηµάτων που χρησιµοποιήθηκαν για την 
σχεδίαση / κατασκευή, προς ευκολία του αναγνώστη. 
     Π.χ η κωδικοποίηση 3.1.Β1 σηµαίνει ότι η παράγραφος που ακολουθεί 
αναφέρεται στο 1ο βήµα ( _ . _ .”Β1” ), του 1ου υποκεφαλαίου ( _ . “1” . _ ), του 3ου 
κεφαλαίου (.“3” . _ . _) της σχεδίασης. Η συγκεκριµένη κωδικοποίηση θα 
ακολουθείται σε όλο το κείµενο της διπλωµατικής εργασίας, ώστε κάθε στιγµή ο 
αναγνώστης να βρίσκεται σε θέση να αντιλαµβάνεται σε πιο σηµείο της κατασκευής 
της Τριήρους βρισκόµαστε. 
     Ο συµβολισµός  π.χ  View → Background Bitmap → Place  περιγράφει 
µια  ενδεικτική  ακολουθία  εντολών  του συστήµατος  CAD  που  χρησιµοποιούµε  
(αρχικά για το σύστηµα CAD / RHINOCEROS 3 και στη συνέχεια για το σύστηµα 
CAD / CATIA V5). 
 
Η εισαγωγή / ψηφιοποίηση των δεδοµένων, η αποτύπωση / εξοµάλυνση των νοµέων 
στις πραγµατικές τους διαστάσεις και τελικά η διαµόρφωση της γάστρας της 
Τριήρους πραγµατοποιείται στα βήµατα ( Β1, Β2,..., Β8 ) που ακολουθούν. 
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3.1.Β1. Εισαγώγη του Bitmap στο σύστηµα σχεδίασης  Rhinoceros:  
 
Από τη γραµµή εντολών του συστήµατος  Rhinoceros  και µε την ακόλουθη 
διαδικασία τοποθετούµε το Bitmap 
 
View → Background Bitmap → Place  
 
Επιλέγουµε το αρχείο trireme tif. και γίνεται η εισαγωγή στο σύστηµα. 
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3.1.Β2. Αλλαγή µονάδας µέτρησης του συστήµατος: 
 
Αλλάζουµε τις µονάδες µάτρησης του συστήµατος σε µέτρα µε την ακολουθία 
εντολων 
 
File → Properties → Units → Model Units → Meter 
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3.1.Β3. Μεταφορά των αξόνων στο σηµείο τοµής της Center Line µε 
την τρόπιδα 
 
Μεταφέρουµε τους άξονες στο σηµείο τοµής της Center Line µε την τρόπιδα ως εξής. 
 
View → Set  plane → Origin 

 

 
 
3.1.Β4. Αλλαγή κλίµακας του Bitmap 
 
Χρησιµοποιούµε βοηθητική γραµµή: 
 
Command → Start Polyline (0,0,0) → End Polyline (5,0,0) 
 
Μεταφέρουµε την αρχή της γραµµής στο 0  της κλίµακας του Bitmap. 
Προσαρµόζουµε το Bitmap έτσι ώστε το τέλος της βοηθητικής γραµµής να συµπέσει 
µε το τέλος της κλίµακας του Bitmap. 
 
View → Background Bitmap → Scale  
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Χαράσουµε τις καµπύλες επί των νοµέων του Bitmap. Φέρνουµε τα βοηθητικά 
τµήµατα ευθειών που απεικονίζουν τις CL και DECK SIDE LINE µε σηµεία ελέγχου 
ακριβώς στα σηµέια έναρξης και τέλους των νοµέων. Αυτό, χρησιµοποιώντας την 
εντολή end µας εξασφαλίζει κοινά σηµεία έναρξης χ=0, ψ=0 και σηµεία τέλους 
ζ=2.12 m (νοµείς 3- 20). 
 
Start polyline → start point (0,0,0) → end point (τα σηµεία 
έναρξης των νοµέων πάνω στην CL δηλαδή τµήµατα ευθειών µε πατηµένη την 
εντολή ortho). Οµοίως εργαζόµαστε και για την DECK SIDE LINE. 
 
3.1.Β5. Ψηφιοποίηση – Αντιγραφή των νοµέων στις πραγµατικές 
τους διαστάσεις: 
Χαράσουµε / αποτυπώνουµε τους νοµείς στις πραγµατικές τους διαστάσεις µε χρήση 
της εντολής 
 
Command → InterCrv  
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3.1.Β6. Εξοµάλυνση νοµέων 
 
Για να εµφανίσουµε την καµπυλότητα των νοµέων επιλέγουµε τους νοµείς µε 
αριστερό κλικ και από τη γραµµή εντολών επιλέγουµε 
 
Curve → Curvature Graph on 

 

 
 
  
Στη συνέχεια για την εξοµάλυνση των νοµέων ακολουθούµε τα εξής βήµατα. 
 
Χρησιµοποιώντας την εντολή Rebuild εξοµαλύνουµε την καµπύλη και ελέγχουµε 
την απόκλισή της από την αρχική ανάλογα µε τον αριθµό των σηµείων που την 
παρεµβάλλουν. 
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Command → Rebuild → Αυξοµείωση σηµείων → Preview → 
Επιλέγουµε σηµεία µε την µικρότερη απόκλιση από την 
καµπύλη → OK 

 

 
 
Στη συνέχεια για την περαιτέρω εξοµάλυνση χρησιµοποιούµε την εντολή fair µε 
κατάλληλη εισαγωγή της απόκλισης από την αρχική καµπύλη (Tolerance=0.001) 
 
Curve → Curve edit tools → fair → Tolerance → OK    
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3.1.Β7. Κατοπτρισµός των νοµέων και τοποθέτησή τους κατά το 
διαµήκη άξονα : 
 
Επιλέγουµε τους πρωραίους νοµείς και για κάθε ένα νοµέα ξεχωριστά 
χρησιµοποιώντας την εντολές  mirror  και ortho κατοπτρίζουµε τους νοµείς ως προς 
τον άξονα ζ. 
 
Αριστερό κλίκ επί του νοµέα → mirror µε πατηµένο το ortho 
→ start point ( αρχή του νοµέα µε πατηµένο το end) → 
αριστερό κλίκ  
 
Το ίδιο για όλους τους πρωραίους  νοµείς. Οπότε έχουµε όλους τους νοµείς σε µια 
όψη και είµαστε σε θέση να τους  τοποθετήσουµε κατά τον διαµήκη άξονα χ. Η 
ισαπόσταση των νοµέων  προκύπτει µε κατάλληλη αλλαγή κλίµακας του bitmap. 
 

 
 
Από το σχέδιο των ισάλων µετά την αλλαγή κλίµακας µετράµε την ισαπόσταση των 
νοµέων, η οποία προκύπτει 1,60 m. 
  
Γραµµή εντολών → horizontal dimension → αριστερό κλίκ → 
start point ( το σηµείο εναρξης της απόστασης που θέλουµε 
να µετρήσουµε) → αριστερό κλίκ στο end point. 
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Επιλέγουµε την όψη perspective και τοποθετούµε το σύστηµα των αξόνων στο 
τελευταίο σηµείο (πιο κοντινό  µε την B.L.) του κάθε νοµέα. 
 
 ∆εξί κλίκ στο εικονίδιο perspective  →  cet plane → 
origin → αριστερό κλίκ στο τελευταίο σηµείο του νοµέα. 
 
Στη συνέχεια γίνεται τοποθέτηση κατά τον διαµήκη άξονα: 
  
Command : move → αριστερό κλίκ στο νοµέα → point to move 
from (0,0,0) → point to move to ( απόσταση νοµέα, 0,0)  
  
Να σηµειωθεί ότι, οι νοµείς 7,8,9,10 είναι ίδιοι όπως και οι 11,12,13,14,15 
(παράλληλο τµήµα ) και αναπαράγονται ως εξής: µε πολλαπλό mirror σε κατάλληλη 
απόσταση (κατά χ ) και το ίδιο ζ. 
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3.1.B8. Κατασκευή βοηθητικών νοµέων λόγω έλλειψης στοιχείων για 
το κλείσιµο της επιφάνειας του σκάφους: 
 
Νοµέας 23 : Χρησιµοποιούµε το bitmap των ισάλων→ φέρνουµε την κάθετη στον 
άξονα των χ στην ισαπόσταση των νοµέων → βρίσκουµε τα σηµεία τοµής µε τις 
ισάλους (διαιρούµε τις αποστάσεις µε 4,7708 για να µεταβούµε στην κατάλληλη 
κλίµακα  κατά ψ ) → εισάγουµε τα σηµεία που προέκυψαν στο σχέδιο νοµέων και 
χαράσουµε την καµπύλη µε τον γνωστό τρόπο → µεταφορά του νοµέα στη σωστή 
θέση όπως στο προηγούµενο βήµα.  
 
Νοµείς 1, 2, 2.5 : Λόγω έλλειψης στοιχείων η χάραξη των νοµέων γίνεται κατά την 
προσωπική µας εκτίµηση και µε χρήση του προφίλ του πλοίου. Εδώ αξίζει να 
σηµειώθεί ότι η χάραξη των νοµέων επαναλήφθηκε αρκετές φορές ώσπου να 
επιτευχθεί η οµαλότητα της γάστρας και η οµοιότητα του σκάφους µε εκείνο του 
θέµατος χωρίς να αποκλίνουµε απο το ολικό µήκος του σκάφους. 
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3.2 ΑΝΑΛΥΤΙΚΗ ΣΧΕ∆ΙΑΣΗ ΤΗΣ ΑΘΗΝΑΪΚΗΣ 
ΤΡΙΗΡΟΥΣ ΚΑΙ ΤΩΝ ΚΑΤΑΣΚΕΥΑΣΤΙΚΩΝ ΤΗΣ 

ΛΕΠΤΟΜΕΡΕΙΩΝ ΜΕ  ΧΡΗΣΗ ΤΟΥ 
ΣΥΣΤΗΜΑΤΟΣ CAD: CATIA V5 

  
 

Το κεφάλαιο αυτό αποτελεί το κύριο µέρος της παρούσης διπλωµατικής εργασίας.  
 
    Για την σχεδίαση / κατασκευή του τρισδιάστατου λεπτοµερούς γεωµετρικού 
µοντέλου της Τριήρους χρησιµοποιήθηκε το σύστηµα σχεδίασης CAD / CATIA V5. 
Ο τρόπος κωδικοποίησης των κεφαλαίων / υποκεφαλαίων / βηµάτων και ο 
συµβολισµός της ακολουθίας εντολών του συστήµατος  είναι όµοιος µε εκείνον που 
περιγράφηκε στο προηγούµενο κεφάλαιο. 
 
    Με χρήση του συστήµατος σχεδίασης  CAD / CATIA V5 εισαγάγαµε τους 
θεωρητικούς νοµείς (3.2.1) της Τριήρους (όπως σχεδιάστηκαν / εξοµαλύνθηκαν και 
αποτυπώθηκαν µε το συστηµα RHINOCEROS 3) οι οποίοι µε κατάλληλη 
επεξεργασία προσοµοίωσαν την γάστρα του σκάφους (3.2.2). Στη συνέχεια µε 
κατάλληλη χρήση εντολών του συστήµατος, έγινε η εισαγωγή των ενισχύσεων του 
σκάφους κατά το εγκάρσιο και κατά το διάµηκες (3.2.3) σύµφωνα µε τα 
κατασκευαστικά σχέδια του 2ου κεφαλαίου. Ακολούθησε η σχεδίαση των στηρίξεων / 
θέσεων των κωπηλατών και των τριών ενδιάµεσων καταστρωµάτων του σκάφους 
(3.2.4). Έπειτα σχεδιάστηκε το υπερυψωµένο κατάστρωµα και ο διάδροµος του 
κυρίου καταστρώµατος της Τριήρους (3.2.5). Τελικά, έχοντας προσοµοιώσειτην 
γεωµετρία και δοµή του κυρίου µέρους της γάστρας, δώσαµε  τελική µορφή στην 
Τριήρη µε την σχεδίαση / προσθήκη των κατασκευαστικών λεπτοµερειών της πλώρης 
(3.2.6), της πρύµνης (3.2.7), των ιστίων (3.2.8), του συστήµατος πηδαλιούχησης 
(3.2.9), των κουπιών (3.2.10) και λοιπών δευτερευουσών κατασκευαστικών και 
εικαστικών λεπτοµερειών που κρίθηκαν απαραίτητες (3.2.11). 
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3.2.1 ΘΕΩΡΗΤΙΚΟΙ ΝΟΜΕΙΣ 
 
3.2.1.Β1. Εισαγωγή των θεωρητικών νοµέων στο πρόγραµµα CATIA  
             V5 
 
    Στo προηγούµενο καφάλαιο, οι νοµείς της τριήρους εξοµαλύνθηκαν και 
τοποθετήθηκαν σε ισαποστάσεις κατά τον άξονα ¨χ¨ µε χρήση του προγράµµατος 
Rhinoceros 3. Τώρα από την γραµµή εντολών του προγράµµατος CATIA V5  και µε 
την ακόλουθη διαδικασία  τοποθετούµε τους εξοµαλυµένους νοµείς ώστε αυτοί να 
χρησιµοποιηθούν για την περαιτέρω σχεδίαση της τριήρους. 
 
File → Open →  Trireme.igs →  Open 
  
Και η εισαγωγή των νοµέων πραγµατοποιήθηκε όπως φαίνεται στο παρακάτω σχήµα: 
 
 

 
 
Να σηµειωθεί ότι θα σχεδιαστεί το µισό γεωµετρικό σχήµα της Τριήρους και στην 
συνέχεια χρησιµοποιώντας κατάλληλη µέθοδο θα κατασκευάσουµε το συµµετρικό 
της µέρος. 
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3.2.1.B2. Επιλογή σχεδιαστικής µεθόδου 
  
Start → Shape →  Generative Shape Design →  Enter name: 
Trireme →ok  
 
είναι η σχεδιαστική µέθοδος του  CATIA V5  που θα χρησιµοποιήσουµε για την 
αναλυτική σχεδίαση της Τριήρους. 
 
 
3.2.1.B3. Εισαγωγή υποκαταλόγων στο «δέντρο σχεδίασης» 
 
Insert → Geometrical set →  Name: π. χ  Κατασκευή γάστρας  
→ ok 
 
Είναι ο τρόπος δηµιουργίας υποκαταλόγων στο δένδρο σχεδίασης του συστήµατος 
για ευκολότερη χρήση, εύρεση  και διόρθωση των µερών της σχεδίασης. 
 

 
 
Για την περαιτέρω σχεδίαση της Τριήρους  στο CATIA θα χρησιµοποιήσουµε µόνο 
τις εξοµαλυµένες splines που περιγράφουν τους θεωρητικούς νοµείς. Η καµπύλη της 
τρόπιδας (keel) και η καµπύλη του κυρίου καταστρώµατος (deck side line), που 
προήλθαν απο το Rhinoceros 3, θα χρησιµοποιηθούν στην αρχή ως βοηθητικές  και 
στην συνέχεια θα ξανασχεδιαστούν. 
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3.2.2 ΕΠΙΦΑΝΕΙΑ ΓΑΣΤΡΑΣ 
 
3.2.2.B1. ∆ηµιουργία επιµέρους πλευρικών επιφανειών της γάστρας 
της Τριήρους  
 
Έχοντας δύο εξοµαλυµένους νοµείς και τις καµπύλες της τρόπιδας και του 
καταστρώµατος, µπορούµε να δηµιουργήσουµε µέρος της επιφάνειας της γάστρας ως 
εξής : 
 
Insert → Surfaces → Multi-section Surface → ok  → εµφανίζεται 
το παράθυρο “Multi-section Surface Definition” → επιλέγουµε µε αριστερό κλίκ τις 
καµπύλες που επιθυµούµε να περιγράψουν την επιφάνεια και επιλέγουµε ok. 
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Ακριβώς την ίδια διαδικασία ακολουθούµε, ανά δύο νοµείς,  για να κατασκευάσουµε 
όλες τις επιµέρους επιφάνειες της γάστρας. Εξασφαλίζουµε γεωµετρική συνέχεια G1 
των εφαπτοµενικών επιφανειών, µε την εντολή Tangent (που εµφανίζεται  στο 
παράθυρο “Multi-section Surface Definition” ).  
 
 

 
 
 
Οι επιφάνειες της πλώρης και της πρύµνης της Τριήρους θα κατασκευαστούν 
πρόχειρα στην αρχή, για δική µας βοήθεια στην σχεδίαση, και στην συνέχεια θα 
ξανασχεδιαστούν και θα περιγραφούν πλήρως. 
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3.2.2.B2. Κατασκευή της τρόπιδας της Τριήρους 
 
Η σχεδίαση της καµπύλης της τρόπιδας θα γίνει σε επίπεδο xz ίδιο µε εκείνο που 
προήλθε από το Rhinoceros 3, ώστε να εξασφαλίσουµε ότι τα ακραία σηµεία των 
καµπυλών των νοµέων βρίσκονται πάνω σε αυτό το επίπεδο. 
      Από τα toolbars του CATIA επιλέγουµε την εντολή plane µε αριστερό κλίκ όπως 
παρακάτω : 
 
Plane → Plane type (Through three points) → Points 
( επιλογή 3 συνεχόµενων ακραίων σηµείων νοµέων) → ok  
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Χαράσουµε την  νέα καµπύλη της τρόπιδας πάνω στο προηγούµενο επίπεδο “ plane 
πάνω στην γάστρα” ως εξής: 
 
Insert → Sketcher →  Sketch → ok  
 
Και επίλεγοντας από τα toolbar του CATIA την εντολή Spline χαράσουµε την 
καµπύλη της τρόπιδας. 
 

 
 
 
Για να κατασκευάσουµε την τρόπιδα της τριήρους θα χρησιµοποιήσουµε το 
προηγούµενο sketch “ σχεδιασµός της spline  του keel “ και τις εντολές  3d Curve 
Offset, Surface και Extrude. 
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Για το ύψος z της τρόπιδας χρησιµοποιώ την εντολή 3d Curve Offset : 
 
Insert → Wireframe →  3d Curve Offset → ok  
Curve → επιλογή του sketch της τρόπιδας 
Pulling direction → επιλογή “ plane πάνω στην γάστρα ”  
Offset → 200mm (από κατασκευαστικά σχέδια της Τριήρους) 
→ok 

 
 

 
 
 
∆ηµιουργήσαµε µια καµπύλη στο ίδιο επίπεδο µε την “ σχεδιασµός της spline  του 
keel “ σε ισαπόσταση 200 mm. Από τις δυο παράλληλες καµπύλες είναι δυνατόν να 
κατασκευάσουµε την επιφάνεια της τρόπιδας σε επίπεδο xz µε την εντολή Surface ως 
εξής : 
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Insert → Surfaces →  Blend → ok  
First Curve → επιλογή του sketch της τρόπιδας 
Second Curve → επιλογή “ 3D Curve Offset ”  
ok 

 
 

 
 
 
Για το πάχος y της τρόπιδας χρησιµοποιούµε την εντολή  Extrude : 
 
Insert → Surfaces →  Extrude  
Profile → επιφάνεια του keel 
Direction → επιλογή “ plane πάνω στην γάστρα ”  
Limit 1 → dimension →  100mm (από κατασκευαστικά σχέδια 
της Τριήρους)  
Limit 2 → dimension →  0mm →ok 
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Η τρόπιδα της Τριήρους σχεδιάστηκε. 
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3.2.2.B3. Σχεδίαση του Profile και των πρωραίων νοµέων της πλώρης 
 
Η σχεδίαση του profile της πλώρης θα µας βοηθήσει στην κατασκευή των πρωραίων 
νοµέων (που δεν υπάρχουν λόγω έλλειψης στοιχείων), ώστε να ολοκληρωθεί η  
πλευρική επιφάνεια της γάστρας στο πρωραίο τµήµα. Το profile της πλώρης 
λαµβάνεται από το σχέδιο γενικής διάταξης της Τριήρους. Η σχεδίαση όπως και πριν 
θα γίνει χρησιµοποιώντας την εντολή sketch ( µε splines και lines ) στο xz επίπεδο. 
 
Insert → Sketcher →  Sketch → ok  
Επιλογή spline → χάραξη της πρώτης spline ( µε 4 σηµεία 
ελέγχου) 
 
Όµοια για τις επόµενες splines-lines που συνθέτουν το profile. 
(Η επόµενη line-spline που ακολουθεί, πάντα ξεκινά απο το τελευταίο σηµείο της 
προηγούµενης.) 
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Εφόσον σχεδιάστηκε το profile µε την εντολή surface σχηµατίζουµε την επιφάνεια 
του profile της πλώρης.  
 
Χρησιµοποιώντας την εντολή sketch αλλά σε xy επίπεδο χαράσουµε τους πρωραίους 
νοµείς όπως φαίνεται πιο κάτω : 
 
 

 
 
Οι νοµείς θα µεταφερθούν κατά µήκος στην σωστή θέση µε την εντολή translate ως 
εξής : 
 
Insert → Operations →  Translate → ok 
Element → νοµέας πλώρης 1 
Direction → plane 3 
Distance → µε πατηµένο το αριστερό κλίκ µεταφέρουµε τον 
νοµέα στην θέση που θέλουµε → ok ( η απόσταση µπορεί να 
δοθεί και µε αριθµητική τιµή) 
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Τοποθετήσαµε τους πρωραίους νοµείς στη σωστή θέση κατά την διέυθυνση x. Στη 
συνέχεια, κατά τον ίδιο τρόπο όπως προηγουµένως, µε την εντολή blend φέρουµε τις 
επιφάνειες που παρεµβάλουν τους πρωραίους νοµείς και χρησιµοποιώντας και το 
profile της πλώρης ολοκληρώνουµε την πλευρική επιφάνεια της γάστρας στο 
πρωραίο τµήµα. 
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3.2.2.B4. Κατασκευή του πρυµναίου τµήµατος της γάστρας  
 
Για να κατασκευάσουµε την πλευρική επιφάνεια του πρυµναίου τµήµατος της 
γάστρας θα χρησιµοποιήσουµε την εντολή Multi-sections Surface ως εξής : 
 
Insert → Surfaces →  Multi-section surfaces → ok 
Εµφανίζεται το παράθυρο Multi-sections Surface Definition 
Section 1 → η ακµή της τελευταίας πλευρικής επιφάνειας 
της γάστρας 
Section 2 → spline που ενώνει την καµπύλη του 
καταστρώµατος µε την ακµή της τρόπιδας 
Guide 1 → η ακµή της τρόπιδας της τριήρους 
Guide 2 → spline  που ακολουθεί την καµπύλη του 
καταστρώµατος 
ok 
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3.2.2.B5. Κατασκευή του συµµετρικού τµήµατος της γάστρας 
 
Με την ολοκλήρωση όλων των πλευρικών επιφανειών που συνθέτουν την γάστρα της 
Τριήρους, θα χρησιµοποιήσουµε κατάλληλη σχεδιαστική µέθοδο, για να 
δηµιουργήσουµε το συµµετρικό της µέρος. 
 
Αρχικά κατασκευάσαµε επίπεδο το οποίο τέµνει την τρόπιδα της Τριήρους στην µέση 
και το οποίο από εδώ και πέρα θα χρησιµοποιείται ως επίπεδο συµµετρίας για 
οποιοδήποτε κατασκευαστικό µέρος του σκάφους που θέλουµε να σχεδιάσουµε το 
συµµετρικό του. Το επίπεδο το ονοµάσαµε “ plane στη µέση του keel “ και έγινε 
χρησιµοποιώντας γνωστή µέθοδο. 
 
Στη συνέχεια χρησιµοποιούµε την εντολή Symmetry για κάθε ένα από τα πλευρικά 
τµήµατα της γάστρας µε σκοπό την δηµιουργία των συµµετρικών τους ως εξής : 
 
Insert → Operations →  Symmetry → ok 
 
Εµφανίζεται το παράθυρο Symmetry Definition 
 
Εlement → επιλογή του επιφανειακού τµήµατος που θέλουµε 
να κατασκευάσουµε το συµµετρικό του 
Reference → plane στη µέση του keel 
Ok 
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3.2.2.B6. Πάχος της γάστρας  
 
Είναι το τελευταίο µέρος  της κατασκευής της γάστρας της Τριήρους. Στο σηµείο 
αυτό αποµένει να δώσουµε το απαιτούµενο πάχος στα πλευρικά επιφανειακά 
τµήµατα. Αυτό είναι δυνατόν να γίνει µε χρήση της εντολής Extrude ως εξής : 
 
Insert → Surfaces →  Extrude → ok 
Εµφανίζεται το παράθυρο Extrude Definition 
 
Profile → επιφάνεια που θέλουµε να δώσουµε πάχος 
Direction → y axis 
Limit 1 → 50mm (από κατασκευαστικά σχέδια) 
Limit 2 → 0mm 
ok 
 

 
 
 
Η διαδικασία επαναλαµβάνεται για κάθε  επιφανειακό τµήµα. 
 
 

 
 



 44 

3.2.3 ΕΓΚΑΡΣΙΕΣ & ∆ΙΑΜΗΚΕΙΣ ΕΝΙΣΧΥΣΕΙΣ 
 
3.2.3.B1. ∆ηµιουργία οπών στη γάστρα για την δίοδο των κουπιών 
 
Από το σχέδιο γενικής διάταξης της Τριήρους καθορίζονται το µέγεθος, η 
ισαπόσταση και το ύψος που βρίσκονται οι οπές των κουπιών.  
 
Για την κατασκευή των οπών, στο πρώτο κατάστρωµα (των θαλαµιτών), χαράσουµε 
βοηθητική γραµµή που έχει µήκος από το κέντρο της πρώτης πρυµναίας οπής έως το 
κέντρο της τελευταίας πρωραίας οπής. Το ύψος της κατά τον άξονα z είναι λίγο πάνω 
από την ίσαλο γραµµή και προκύπτει από το σχέδιο γενικής διάταξης του σκάφους. 
 
Η χάραξη της βοηθητικής γραµµής γίνεται µε χρήση της εντολής Sketch 
(υποκατάλογος “ οπές κουπιών 1 “) σε επίπεδο xz όπως φαίνεται παρακάτω : 
 

 
 
Στη συνέχεια προβάλουµε την βοηθητική γραµµή πάνω στην επιφάνεια της γάστρας  
µε την εντολή Projection ως εξής : 
 
Insert → Wireframe →  Projection → ok 
Εµφανίζεται το παράθυρο Projection Definition 
 
Projection type → along a direction 
Projected → η βοηθητική γραµµή (sketch.103)  
Support → το µέρος της επιφάνειας της γάστρας που θα 
γίνει η προβολή  (join 5) 
Direction → y Axis 
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Από τα toolbars του CATIA στη δεξιά πλευρά επιλέγω την εντολή Points and Planes 
Repetition µε σκοπό την δηµιουργία πολλαπλών σηµείων τα οποία θα αποτελέσουν 
τα κέντρα των οπών των κουπιών. Αυτά θα βρίσκονται πάνω στην προβεβληµένη 
γραµµή (project 3) και σε ισαπόσταση µεταξύ τους. 
 
Points and Planes Repetition → ok 
Εµφανίζεται το παράθυρο Point definition 
Point type → on curve 
Curve → η προβεβληµένη γραµµή (project 3) 
Distance to reference → distance on curve 
ok 
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Έχουµε εξασφαλίσει ότι τα κέντρα των οπών των κουπιών βρίσκονται πάνω στην 
επιφάνεια της γάστρας και σε ισαπόσταση µεταξύ τους. ∆ηµιουργούµε κάθε οπή 
ξεχωριστά µε την εντολή Hole ως εξής : 
 
Insert → BiW Templates → Hole 
Εµφανίζεται το παράθυρο Hole Definition 
 
Αριστερό κλίκ στην διάσταση  → 300mm (από κατασκευαστικά 
σχέδια) → ok 
Center point → επιλογή ενός σηµείου (π.χ point 1629) 
Support Surface → αριστερό κλίκ στην επιφάνεια που ανήκει 
το   επιλεγµένο σηµείο 
ok 
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Η διαδικασία επαναλαµβάνεται για όλες τις οπές. Στη συνέχεια δηµιουργούµε νέο 
υποκατάλογο “ οπές κουπιών 2 “ και εργαζόµαστε ακριβώς µε τον ίδιο τρόπο, µε 
σκοπό την  δηµιουργία δεύτερης σειράς οπών που ανήκουν στο δεύτερο εσωτερικό 
κατάστρωµα (των ζυγιτών). Η γάστρα της Τριήρους µε τις δύο σειρές οπών είναι 
όπως φαίνεται πιο κάτω : 
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3.2.3.B2. Κατασκευή των άνω εγκάρσιων ενισχυτικών της γάστρας  
 
Με την βοήθεια των κατασκευαστικών σχεδίων της µέσης τοµής της Τριήρους θα 
σχεδιαστούν τα άνω εγκάρσια ενισχυτικά. Το µήκος, το πάχος και το ύψος των 
ενισχυτικών υπολογίστηκε µε χρήση κλίµακας που προέκυψε από γνωστά 
γεωµετρικά στοιχεία. Επίσης να σηµειωθεί ότι το πάχος των ενισχυτικών δεν µπορεί 
να υπερβεί µια συγκεκριµένη τιµή λόγω του αριθµού των οπών που βρίσκονται σε 
κοντινές ισαποστάσεις. 
 
Τα άνω εγκάρσια ενισχυτικά είναι υλωµένα στην εσωτερική επιφάνεια της γάστρας. 
Για αυτό το λόγο χρειάζεται να εξασφαλίσουµε ότι κάθε ενισχυτικό εφάπτεται 
εσωτερικα της γάστρας. Συνεπώς η σχεδίαση θα γίνει όπως και στη δηµιουργία οπών 
στη γάστρα που αναφέρθηκε προηγούµενα (παράγραφος 1). Αρχικά φέρουµε 
βοηθητικό πλαίσιο(κάτοψη ενισχυτικού), στο επίπεδο xz, µε µήκος ίσο µε εκείνο του 
ενισχυτικού που θέλουµε να σχεδιάσουµε, χρησιµοποιώντας την εντολή Sketch (σε 
νέο υποκατάλογο “ άνω εγκάρσια ενισχυτικά”). Στη συνέχεια προβάλουµε τo 
βοηθητικό πλαίσιο πάνω στην εσωτερική επιφάνεια της γάστρας µε την εντολή 
Projection. 
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Μετατρέπουµε το προβεβληµένο πλαίσιο σε επιφάνεια µε την εντολή Fill ως εξής : 
 
Insert → Surfaces → Fill → ok 
 
Εµφανίζεται το παράθυρο Fill Surface Definition 
 
Επιλέγουµε το προβεβληµένο πλαίσιο ( π. χ Project.30) → ok 
 
Η επιφάνεια που σχηµατίστηκε, µε χρήση της γνωστής εντολής Extrude   (στην y 
διεύθυνση), θα µας δώσει το απαιτούµενο ύψος του ενισχυτικού (100mm). 
 

 
 
Η κάτω ακµή του ενισχυτικού που κατασκευάστηκε χρειάζεται διαµόρφωση ώστε να 
αποκτήσει την σωστή καµπυλότητα όπως αυτή παρουσιάζεται στο κατασκευαστικό 
σχέδιο της µέσης τοµής. Αυτό το επιτυγχάνουµε µε την εντολή Edge Fillet ως εξής : 
 
Insert → Operations → Edge Fillet → ok 
Εµφανίζεται το παράθυρο Edge Fillet Definition 
 
Support → το ενισχυτικό 
Radius → 100mm 
Objects to fillet → η κάτω ακµή του ενισχυτικού 
ok 



 50 

 
 
Το  άνω εγκάρσιο ενισχυτικό κατασκευάστηκε. Η διαδικασία που περιγράφηκε 
επαναλαµβάνεται για όλα τα άνω εγκάρσια ενισχυτικά. 
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3.2.3.B3. Κατασκευή των µεσαίων εγκάρσιων ενισχυτικών της 
γάστρας  
 
Από το κατασκευαστικό σχέδιο της µέσης τοµής της Τριήρους σχεδιάζονται τα 
µεσαία εγκάρσια ενισχυτικά µε τον ίδιο τρόπο που σχεδιάστηκαν και τα άνω 
εγκάρσια ενισχυτικά. 
 
∆ηλαδή στην αρχή σχεδιάζουµε την κάτοψη του ενισχυτικού (σε νέο υποκατάλογο “ 
µεσαία εγκάρσια ενισχυτικά “), σε επίπεδο xz χρησιµοποιώντας την εντολή Sketch 
στην συνέχεια προβάλουµε στην γάστρα µε την εντολή Projection. 
 

 
 
Στην προβολή του ενισχυτικού εφαρµόζουµε την εντολή Fill  για την δηµιουργία 
επιφάνειας και στη συνέχεια τις εντολές Extrude και Edge Fillet (και για τις δύο 
ακµές) για την τελική διαµορφωση του ενισχυτικού. 
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Η προηγούµενη διαδικασία επαναλαµβάνεται για κάθε µεσαίο εγκάρσιο ενισχυτικό 
χωριστά και η γάστρα παίρνει την µορφή : 
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3.2.3.B4. Κατασκευή των κάτω εγκάρσιων ενισχυτικών της γάστρας  
 
Το κατασκευαστικό σχέδιο της µέσης τοµής της Τριήρους θα µας δώσει τις 
απαραίτητες πληροφορίες για την σχεδίαση των κάτω εγκάρσιων ενισχυτικών. Ο 
τρόπος σχεδίασης διαφέρει από αυτόν που περιγράφτηκε  για τα άνω και µεσαία 
εγκάρσια ενισχυτικά αντίστοιχα. 
 
Όπως φαίνεται και από το κατασκευαστικό σχέδιο της µέσης τοµής, τα κάτω 
εγκάρσια ενισχυτικά αποτελούνται, σε όλο το µήκος της γάστρας, από δύο κοµµάτια. 
Από ένα κοµµάτι σφηνοειδούς µορφής που είναι απαραίτητο για την σύνδεση της 
τρόπιδας και της γάστρας του σκάφους και από ένα άλλο το οποίο είναι υλωµένο 
στην πάνω επιφάνεια του προηγούµενου. Το τελευταίο έχει µορφή παρόµοια µε αυτή 
των άνω και µεσαίων εγκάρσιων ενισχυτικών. 
 
Όπως αναφέραµε και πριν, το πρώτο κοµµάτι των κάτω εγκάρσιων ενισχυτικών 
χρησιµοποιείται για την σύνδεση της τρόπιδας και της γάστρας της Τριήρους. Αυτός 
είναι και ο λόγος που αρχικά πρέπει να εξασφαλίσουµε ότι το πρώτο κοµµάτι του 
ενισχυτικού έχει απόλυτη εφαρµογή µε την τρόπιδα και στην συνέχεια µε την γάστρα 
του σκάφους. 
 
Συνεπώς θα σχεδιάσουµε µια spline σε επίπεδο που βρίσκεται στο µέσο της τρόπιδας 
( “plane στη µέση του keel “). Στην καµπύλη αυτή δηµιουργούµε σηµεία ( points) που 
θα χρησιµοποιηθούν ως σηµεία αναφοράς για την σχεδίαση του πρώτου µέρους των 
κάτω εγκάρσιων ενισχυτικών. 
 
Χρησιµοποιούµε την εντολή Positioned Sketch ως εξής : 
 
Insert → Sketcher → Positioned Sketch → ok 
 
Εµφανίζεται το παράθυρο Sketch Positioning 
 
Reference → plane στη µέση του keel → ok 
 
Από τα δεξιά toolbars του CATIA επιλέγουµε την εντολή 
spline και χαράσουµε την καµπύλη.  



 54 

 
 
Στη συνέχεια επιλέγουµε την εντολή Point και εµφανίζεται το παράθυρο Point 
Definition. 
 
Point type  → on curve 
Curve → η καµπύλη στο µέσο του keel 
 
Μαρκάρουµε το Geodesic  και µε το ποντίκι επιλέγουµε τη 
θέση του σηµείου πάνω στην καµπύλη → ok  
 
Στη συνέχεια επιλέγουµε την εντολή Line και εµφανίζεται το παράθυρο Line 
Definition. 
 
Line type  → point-direction 
Point → το σηµείο που δηµιουργήσαµε πιο πάνω 
Direction  → z axis 
Start → 0mm 
End → το απαιτούµενο ύψος του ενισχυτικού σε επίπεδο xz 
ok 
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    Με την εντολή 3D Curve offset δηµιουργούµε ευθέια η οποία είναι όµοια µε την 
προηγούµενη και βρίσκεται σε απόσταση ίση (κατά την διεύθυνση του x άξονα) µε το 
πάχος του κάτω εγκάρσιου ενισχυτικού. 
    Φέρουµε την επιφάνεια µεταξύ των  δύο ευθειών µε την εντολή Blend και στη 
συνέχεια µε χρήση της εντολής Extrude προεκτείνουµε την επιφάνεια έως ότου αυτή 
τµήσει την επιφάνεια της γάστρας. 
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Το σφηνοειδές κοµµάτι του κάτω εγκάρσιου ενισχυτικού θα κοπεί µε την εντολή 
Spilt ως εξής : 
 
Insert → Operations → Split → ok 
Εµφανίζεται το παράθυρο Split Definition 
 
Element to cut → κλίκ στο σφηνοειδές κοµµάτι 
Cutting Elements → κλίκ στη γάστρα της Τριήρους 
ok 

 
 

 
 
 
    Σχηµατίσαµε το πρώτο κοµµάτι του κάτω εγκάρσιου ενισχυτικού, το οποίο συνδέει 
την τρόπιδα µε την γάστρα της Τριήρους. Κατά τον ίδιο τρόπο εργαζόµαστε για την 
κατασκευή όλων των υπόλοιπων κοµµατιών.  
 
    Για να ολοκληρώσουµε το ενισχυτικό πρέπει να χαράξουµε το δεύτερο κοµµάτι 
που βρίσκεται υλωµένο στην άνω επιφάνεια του πρώτου κοµµατιού. Όπως 
αναφέραµε και στην αρχή της παραγράφου η σχεδίαση είναι όµοια µε αυτή των άνω 
και µεσαίων εγκάρσιων ενισχυτικών. Για λόγους συντοµίας θα παρουσιάσουµε µόνο 
το γραφικό αποτέλεσµα. 
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Η σχεδίαση επαναλαµβάνεται όπως και στις προηγούµενες περιπτώσεις για όλα τα 
κάτω εγκάρσια ενισχυτικά σε όλο το µήκος της γάστρας. 
 

 



 58 

3.2.3.B5. Κατασκευή των άνω, µεσαίων & κάτω διαµηκών 
ενισχυτικών της γάστρας 
 
Τα διαµήκη ενισχυτικά συµβάλουν σηµαντικά στην αντοχή της  κατασκευής της 
γάστρας. Σκοπό έχουν να ‘δέσουν’ την κατασκευή. ∆ηλαδή να κρατήσουν ενωµένα 
τα επιµέρους κατασκευαστικά µέρη όπως είναι οι εγκάρσιες ενισχύσεις και οι σανίδες 
επένδυσης της γάστρας( πέτσωµα). Επίσης θα δούµε παρακάτω ότι θα αποτελέσουν 
τις κύριες στηρίξεις των καθισµάτων των κωπηλατών στα δυο εσωτερικά 
καταστρώµατα. 
 
Η σχεδίαση των διαµηκών ενισχυτικών είναι σχετικά απλή και δεν παρουσιάζει 
διαφοροποιήσεις στις τρεις κατηγορίες (άνω, µεσαία και κάτω ενισχυτικά). Θα 
χρησιµοποιήσουµε γνωστά σχεδιαστικά εργαλεία του CATIA. 
 
Επιλέγουµε την εντολή Point από τα σχεδιαστικά εργαλεία του CATIA και 
εµφανίζεται το παράθυρο Point Definition. 
Point type → on curve 
Curve → επιλέγουµε την πλαϊνή ακµή του µεσαίου εγκάρσιου 
ενισχυτικού 
Μαρκάρουµε distance on curve και µε το ποντίκι τοποθετούµε το σηµείο στην 
απόσταση που επιθυµούµε 
Ok 
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Με την ίδια διαδικασία δηµιουργούµε νέο σηµείο στην ακµή του εγκάρσιου 
ενισχυτικού το οποίο απέχει απόσταση από το προηγούµενο ίση µε το πλάτος του 
διαµήκους ενισχυτικού που θέλουµε να κατασκευάσουµε.  Για κάθε εγκάρσιο 
ενισχυτικό  εφαρµόζουµε την παραπάνω µεθοδολογία. Με αυτό το τρόπο 
σχηµατίζονται δύο σειρές σηµείων, η άνω και η κάτω, οι οποίες βρίσκονται στις 
ακµές των εγκάρσιων ενισχυτικών. 
 
Στη συνέχεια θα χαράξουµε καµπύλες (µε την εντολή Spline) που θα παρεµβάλουν 
τα σηµεία κάθε σειράς χωριστά και θα έχουν µήκος ίσο µε το διαµήκες ενισχυτικό 
που θέλουµε να κατασκευάσουµε. 
  

 
 
Χρησιµοποιούµε  την εντολή Blend για να σχεδιάσουµε την επιφάνεια  µεταξύ των 
δύο καµπυλών και στην συνέχεια την εντολή Extrude (κατά την  z  διεύθυνση) για να 
δώσουµε στο ενισχυτικό το κατάλληλο πάχος. 
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Κατασκευάσαµε ένα µεσαίο διαµήκες ενισχυτικό, σύµφωνα µε το οποίο θα 
προκύψουν και τα υπόλοιπα άνω, µεσαία και κάτω διαµήκη ενισχυτικά, 
ακολουθώντας  ακριβώς την ίδια διαδικασία σχεδίασης. 
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3.2.3.B6. Κατασκευή του διαµήκους ενισχυτικού του κυρίου 
καταστρώµατος 
 
Στα διαµήκη ενισχυτικά της Τριήρους περιλαµβάνεται και το ενισχυτικό του κυρίου 
καταστρώµατος. Εκτείνεται σε όλο το µήκος της γάστρας και ακολουθεί την 
επιφάνεια του καταστρώµατος. Το κάτω µέρος του ενισχυτικού έχει σηµεία στήριξης 
στα άνω εγκάρσια ενισχυτικά και την επιφάνεια της γάστρας. Σκοπό έχει την 
ενίσχυση της αντοχής του σκάφους και την στήριξη των θέσεων κωπηλάτησης των 
θρανιτών.  
 
Η σχεδίαση θα γίνει ως εξής : 
 
Με την εντολή Spline χαράσουµε καµπύλη που παρεµβάλλει τα σηµέια των ακµών 
των άνω εγκαρσίων ενισχυτικών. 
 

 
 
Στη συνέχεια χρησιµοποιούµε την εντολή 3D Curve Offset για να δηµιουργήσουµε 
µια όµοια καµπύλη σε απόσταση ίση µε το πλάτος του ενισχυτικού του κυρίου 
καταστρώµατος (κατά τον y άξονα). 
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Σχηµατίζουµε την επιφάνεια µεταξύ των δύο καµπυλών µε την εντολή Blend και 
δίδουµε το κατάλληλο πάχος µε την εντολή Extrude.  
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3.2.4 ΣΗΜΕΙΑ ΣΤΗΡΙΞΗΣ ΚΑΙ ΘΕΣΕΩΝ ΚΩΠΗΛΑΤΗΣΗΣ 
ΤΩΝ ΤΡΙΩΝ ΚΑΤΑΣΤΡΩΜΑΤΩΝ 

 
3.2.4.B1. Κατασκευή των εγκάρσιων ενισχυτικών των θέσεων της 1ης 
σειράς κωπηλατών  
 
Θέλουµε να εξασφαλίσουµε την σύνδεση των κατασκευαστικών µερών της Τριήρους. 
Για το λόγο αυτό η σχεδίαση των ζητούµενων ενισχυτικών θα ξεκινήσει, από τα 
σηµεία τοµής των άνω διαµηκών ενισχυτικών µε τα άνω εγκάρσια ενισχυτικά, µε την 
εντολή Intersect ως εξής : 
 
Insert → Wireframe → Intersection → ok 
Εµφανίζεται το παράθυρο Intersection Definition 
First Element → κλίκ στο άνω εγκάρσιο ενισχυτικό 
Second Element  → κλίκ στο άνω διάµηκες ενισχυτικό 
ok 

 

 
 
Στη συνέχεια µε την εντολή Line φέρουµε τις ευθείες (στη y διεύθυνση) µε σηµεία 
εκκίνησης τα σηµεία τοµής που προέκυψαν προηγουµένως από την εντολή 
Intersection. 
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Κατασκευάζουµε το άνω µέρος του εγκάρσιου ενισχυτικού χρησιµοποιώντας τις 
εντολές Blend (για την δηµιουργία επιφάνειας µεταξύ των ευθειών) και Extrude (για 
να δώσουµε το απαιτούµενο πάχος). 
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Χρησιµοποιούµε την άνω ακµή του κάτω διαµήκους ενισχυτικού για να 
δηµιουργήσουµε επιφάνεια µε την εντολή Extrude ( κατά την z διεύθυνση ).  
 

 
 
Και στην συνέχεια την εντολή Split για κόψουµε το ενισχυτικό στο σωστό y. 
 

 
 
Η βοηθητική επιφάνεια ‘κρύβεται’ πατώντας δεξί κλίκ πάνω στην επιφάνεια και 
επιλέγοντας την εντολή Hide/Show. 
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Στο επίπεδο που κόψαµε το ενισχυτικό επιλέγουµε την άνω ακµή του ενισχυτικού και 
χρησιµοποιούµε την  εντολή Extrude δύο φορές. Αρχικά για να προεκτείνουµε µέχρι 
την βάση του κάτω διαµήκους ενισχυτικού και στη συνέχεια για να δώσουµε το 
απαραίτητο πάχος του κάτω µέρους του εγκάρσιου ενισχυτικού. 
 

 
 
Επαναλαµβάνουµε την διαδικασία για όλα τα εγκάρσια ενισχυτικά των θέσεων της 
1ης σειράς κωπηλατών.  
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3.2.4.B2. Κατασκευή των διαµηκών ενισχύσεων-στηρίξεων των 
θέσεων της 1ης σειράς κωπηλατών  
 
Για την σχεδίαση των στηρίξεων των θέσεων κωπηλάτησης αρχικά χρησιµοποιούµε 
την εντολή Point για να δηµιουργήσουµε ζεύγη σηµείων επί των ακµών των 
εγκαρσίων ενισχυτικών. Τα σηµεία βρίσκονται σε αντιδιαµετρική θέση και απέχουν 
µεταξύ τους ανά ζεύγος απόσταση ίση µε το πάχος της στήριξης που θέλουµε να 
κατασκευάσουµε.  
 

 
 
Επιλέγουµε την εντολή Line και χαράσουµε τις ευθείες που ενώνουν τα 
αντιδιαµετρικά σηµεία.  
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Στη συνέχεια χρησιµοποιούµε την εντολή Blend για φέρουµε την επιφάνεια µεταξύ 
των ευθειών και την εντολή Extrude για να κατασκευάσουµε την στήριξη. 
 

 
 
Ακολουθούµε τον ίδιο τρόπο για να κατασκεύασουµε όλες τις στηρίξεις των θέσεων 
της 1ης σειράς κωπηλατών. 
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3.2.4.B3. Κατασκευή των θέσεων της 1ης σειράς κωπηλατών  
 
Έχοντας σχεδιάσει όλες τις διαµήκεις στηρίξεις των θέσεων της 1ης σειράς 
κωπηλατών µπορούµε να κατασκεύασουµε τις θέσεις των κωπηλατών ως εξής : 
  
Επιλέγουµε την εντολή Point  και εµφανίζεται το παράθυρο Point Definition  
 
Point type  → on curve 
Curve → επιλέγουµε την άνω ακµή της διαµήκους στήριξης 
που σχεδιάσαµε πρίν 
Distance to reference → µαρκάρουµε Distance on Curve και 
επιλέγουµε Middle Point 
Ok 
 
Συνεπώς σχεδιάσαµε σηµείο που βρίσκεται στη µέση του µήκους της διαµήκους 
στήριξης. Η διαδικασία επαναλαµβάνεται για να σχεδιάσουµε 
νέο σηµείο στην άλλη άνω ακµή της διαµήκους ενίσχυσης. 
 

 
 
Στη συνέχεια χρησιµοποιούµε την εντολή Line  για να κατασκευάσουµε ευθεία που 
παρεµβάλλει τα σηµεία και έχει µήκος ίσο µε το πλάτος της θέσης του κωπηλάτη 
όπως φαίνεται παρακάτω. 
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∆ηµιουργούµε την επιφάνεια της θέσεως χρησιµοποιώντας την εντολή Extrude  
προεκτείνοντας κατά την διεύθυνση της ακµής της διαµήκους στήριξης και σε µήκος 
ίσο µε το µήκος της θέσεως που θέλουµε να κατασκευάσουµε. 
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∆ίνουµε το απαραίτητο πάχος στην επιφάνεια µε χρήση της εντολής Extrude  κατά 
την διεύθυνση z. Στη συνέχεια µε δεξί κλίκ στην επιφάνεια επιλέγουµε χρώµα µε την 
εντολή  Properties  → Color →ok  
 

 
 
Για να κατασκευάσουµε τα πλαϊνά στηρίγµατα των θέσεων κωπηλάτησης 
εργαζόµαστε ως εξής : µε αριστερό κλίκ επιλέγουµε την άνω εγκάρσια ακµή της 
θέσεως κωπηλάτησης και στη συνέχεια την εντολή Point. Στο παράθυρο Point 
Definition που εµφανίζεται µαρκάρουµε Distance on Curve και πληκτρολογούµε 
στο χωρίο δίπλα στο Length : τιµή ίση µε το πλάτος του πλαϊνού στηρίγµατος που 
θέλουµε να κατασκευάσουµε. Επαναλαµβάνουµε για την απέναντι ακµή. 
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Ενώνουµε τα σηµεία µε την εντολή Line και µε την εντολή Blend δηµιουργούµε την 
επιφάνεια του πλαϊνού στηρίγµατος µεταξύ της ευθείας που χαράξαµε και της άνω 
διαµήκους ακµής της θέσεως του κωπηλάτη.  
 

 
 
Χρησιµοποιούµε την εντολή Extrude για να δώσουµε το απαραίτητο ύψος στο 
πλαϊνό στήριγµα της θέσης του κωπηλάτη και την εντολή Edge Fillet για να δώσουµε 
την κατάλληλη διαµόρφωση. 
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Ακριβώς µε τον ίδιο τρόπο ενεργούµε για την κατασκευή του συµµετρικού πλαϊνου 
στηρίγµατος. 
 

 
 
Η διαδικασία επαναλαµβάνεται για κάθε διαµήκη στήριξη της 1ης σειράς θέσεων 
κωπηλάτησης και έχουµε τελικά την κατασκευή των θέσεων των θαλαµιτών. 
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Στο σηµείο αυτό να υπενθυµήσουµε ότι έχουµε δηµιουργήσει τον υποκατάλογο 
«Συµµετρική Γάστρα». Μετά την περάτωση κάθε µέρους της κατασκευής της 
γάστρας της Τριήρους, χρησιµοποιώντας την γνωστή εντολή Symmetry 
δηµιουργούµε το συµµετρικό της µέρος. Με δεξί κλίκ πάνω στον κατάλογο 
«Συµµετρική Γάστρα» και επιλογή της εντολής Hide/Show µπορούµε να 
εµφανίζουµε/κρύβουµε το συµµετρικό µέρος της γάστρας όποτε επιθυµούµε. 
 

 
 
Η κατασκευή της 1ης σειράς θέσεων κωπηλάτησης πάνω στις οποίες κάθονται οι 
θαλαµίτες ολοκληρώθηκε. 
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3.2.4.B4. Κατασκευή των στηριγµάτων της 1ης σειράς κουπιών 
 
Ολοκληρώσαµε την κατασκευή των θέσεων της 1ης σειράς κωπηλατών και θα 
σχεδιάσουµε τα στηρίγµατα των κουπιών που αντιστοιχούν στο κατώτερο 
κατάστρωµα των θαλαµιτών. Τα στηρίγµατα των κουπιών είναι υλωµένα εσωτερικά 
της γάστρας του σκάφους και αποτελούνται από δύο µέρη. 
 Το πρώτο µέρος είναι ένα απλό ενισχυτικό σε µορφή δοκαριού µε διεύθυνση κατά 
τον x άξονα. Χρησιµοποιείται για την εγκάρσια στήριξη του κουπιού κατά τον 
κατακόρυφο άξονα.  
Το δεύτερο µέρος είναι κυλινδρικής µορφής µε κατάλληλη διαµόρφωση στην άνω 
ακµή του. Βρίσκεται πακτωµένο στο πρώτο µέρος του στηρίγµατος κατά την z 
διεύθυνση. Παίζει τον ρόλο της «κόντρας» που είναι απαραίτητη για να έχουµε 
απόδοση στην  κωπηλάτηση. Επίσης µε κατάλληλες στηρίξεις από σχοινιά (δέστρες), 
δεν επιτρέπει την κίνηση των κουπιών κατά την x διεύθυνση. 
 
Η σχεδίαση για την κατασκευή του πρώτου µέρους των στηριγµάτων των κουπιών 
γίνεται µε την χρήση γνωστών σχεδιαστικών εργαλείων του CATIA. Επιλέγουµε την 
ακµή του άνω εγκάρσιου ενισχυτικού που εφάπτεται στην γάστρα. Στη συνέχεια µε 
την εντολή Point  δηµιουργούµε σηµεία επί της ακµής του ενισχυτικού σε 
αποστάσεις µεταξύ τους ίσες µε το πλάτος του στηρίγµατος του κουπιού. Το ίδιο 
εφαρµόζουµε και στην αντικρυστή ακµή του αµέσως επόµενου ενισχυτικού. Τα 
αντιδιαµετρικά σηµεία ενώνονται µε την εντολή Line. 
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Προσέχουµε η πάνω ευθεία να βρίσκεται στο ίδιο ακριβώς ύψος µε το κάτω χείλος 
της οπής του κουπιού ώστε να µην υπάρχουν δυσκολίες στην κίνηση των κουπιού 
κατά την στηριξή του. 
Χρησιµοποιούµε τις εντολες Blend και Extrude για να δηµιουργήσουµε την 
επιφάνεια µεταξύ των ευθειών και στην συνέχεια να κατασκευάσουµε το πρώτο 
µέρος του στηρίγµατος. 
 

 
 
Από το κατασκευαστικό σχέδιο της µέσης τοµής της Τριήρους, δίνουµε την τελική 
διαµόρφωση του πρώτου µέρους  στηριξής των κουπιών µε την εντολή Edge Fillet. 
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Για την κατασκευή του δεύτερου µέρους της  στήριξης, µε την εντολή Point 
δηµιουργούµε σηµεία επί των ακµών του πρώτου µέρους στήριξης κατά τα γνωστά. 
Ενώνουµε µε ευθεία τα σηµεία µε την εντολή Line.  Κατασκευάζουµε νέο σηµείο επί 
της ευθέιας. Αυτό τοποθετείται στη θέση που θέλουµε να δηµιουργήσουµε το 
στέλεχος του δεύτερου µέρους στήριξης. 
 

 
 
 
Insert → Wireframe → Circle → ok 
Εµφανίζεται το παράθυρο Circle Definition 
 
Circle : center and radius 
Center : κλίκ στο προηγούµενο σηµείο 
Support : κλίκ στο πάνω µέρος της επιφάνειας του πρώτου 
µέρους στήριξης 
Radius :  πληκτρολογούµε την ακτίνα του κύκλου που 
θέλουµε να σχεδιάσουµε και ο οποίος θα αποτελέσει την 
βάση για την δηµιουργία του δεύτερου µέρους στήριξης. 
ok 
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Επιλέγουµε τον κύκλο που σχηµατίσαµε και µε την εντολή Fill σχηµατίζουµε την 
επιφάνεια που περικλύει και στην συνέχεια µε την εντολή Extrude σχηµατίζουµε το 
δεύτερο µέρος της στήριξης.  
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Τέλος µε την εντολή Edge Fillet δίνουµε την τελική µορφή στην «κόντρα» της 
στήριξης του κουπιού. 
 

 
 
Η διαδικασία επαναλαµβάνεται για κάθε θέση κωπηλάτησης ξεχωριστά έως ότου 
κατασκευαστούν όλες οι στηρίξεις κουπιών της 1ης σειράς κωπηλατών. 
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3.2.4.B5. Κατασκευή των στηρίξεων- θέσεων της 2ης σειράς 
κωπηλατών 
 
Η κατασκευή των κατακόρυφων εγκάρσιων ενισχυτικών της 2ης σειράς κωπηλατών 
δεν παρουσιάζει κάποια ενδιαφέρουσα διαφοροποίηση από αυτή της 1ης σειράς. 
Γίνεται αρκετά εύκολα µε διπλή χρήση της εντολής Extrude, στο κατάλληλο ύψος 
που προκύπτει από το σχέδιο της µέσης τοµής της Τριήρους. 
 

 
 
     Για την κατασκευή των εγκάρσιων ενισχυτικών που θα αποτελέσουν τις βάσεις 
των στηρίξεων της 2ης σειράς κωπηλατών θα εργαστούµε ως εξής  
     Επιλέγουµε  επίπεδο σχεδίασης yz (πάνω στη επιφάνεια του κατακόρυφου 
ενισχυτικού) µε την εντολή Plane και στη συνέχεια επιλέγουµε την εντολή Sketch.  
Χαράσουµε καµπύλη στο επίπεδο που επιλέξαµε µε την εντολή Spline.  
 

 



 82 

 
 
Χρησιµοποιούµε δύο φορές την εντολή Split για να κόψουµε την καµπύλη. Μία για 
την τοµή της µε το άνω εγκάρσιο ενισχυτικό και µία µε το κατακόρυφο εγκάρσιο 
ενισχυτικό στήριξης όπως παρακάτω : 
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Η καµπύλη που απέµεινε έχει σηµείο εκκίνησης το άνω εγκάρσιο ενισχυτικό και 
σηµείο τέλους το κατακάρυφο ενισχυτικό στήριξης. Με την εντολή 3D Curve Offset 
σχεδιάζουµε νέα καµπύλη η οποία έχει την µορφή της προηγούµενης, βρίσκεται στο 
ίδιο επίπεδο και απέχει απόσταση (κατά τον z άξονα) ίση µε το πλάτος του 
ενισχυτικού που θέλουµε να κατασκευάσουµε. 
Όµοια µε πρίν χρησιµοποιούµε δύο φορές την εντολή Split για να κόψουµε τα άκρα 
της καµπύλης και να εξασφαλίσουµε σωστή εφαρµογή µε τα άλλα δύο ενισχυτικά. 
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Μεταξύ των καµπυλών δηµιουργούµε επιφάνεια µε την εντολή Blend και 
προεκτείνουµε µε την εντολή Extrude σε πλάτος ίσο µε εκείνο του κατακόρυφου 
ενισχυτικού. 
 

 
 
Επαναλαµβάνουµε µέχρι να κατασκευάσουµε όλες τις βάσεις των στηρίξεων των 
θέσεων της 2ης σειράς κωπηλατών. 
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Οι διαµήκεις στηρίξεις των θέσεων, οι θέσεις καθώς και τα στηρίγµατα των κουπιών 
της 2ης σειράς κωπηλατών κατασκευάζονται ακριβώς µε την ίδια διαδικασία που 
κατασκευάστηκαν και στην 1η σειρά κωπηλατών. Για λόγους συντοµίας θα 
παρουσιαστούν µόνο γραφικά. 
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3.2.4.B6. Κατασκευή των στηρίξεων- θέσεων της 3ης σειράς 
κωπηλατών 
 
Η 3η σειρά κωπηλατών βρίσκεται στο κύριο κατάστρωµα της Τριήρους. Οι στηρίξεις 
κατασκευάζονται όµοια µε την 1η και 2η σειρά κωπηλατών. ∆ηλαδή σχεδιάζονται 
αρχικά οι κατακόρυφες εγκάρσιες ενισχύσεις που αποτελούν τις βάσεις των θέσεων 
και στη συνέχεια από βάση σε βάση υπάρχουν τα διαµήκη ενισχυτικά που στηρίζουν 
τις θέσεις των κωπηλάτών. 
 
 Στη συνέχεια δηµιουργούµε σηµεία (εντολή Point) επί των ακµών των εγκάρσιων 
ενισχύσεων του 2ου καταστρώµατος. Φέρουµε τις ευθείες (εντολή Line), κατά την  z 
διεύθυνση, έως το ύψος του κυρίου καταστρώµατος και κατόπιν σχεδιάζουµε τήν 
µεταξύ τους επιφάνεια (εντολή Blend) και κατασκευάζουµε τα εγκάρσια κατακόρυφα 
ενισχυτικά (εντολή Extrude). 
 
Οι θέσεις των κωπηλατών κατασκευάζονται µε την µεθοδολογία που ακολουθήσαµε 
προηγούµενα. 
 

 
 
Στη συνέχεια δηµιουργούµε  ζεύγη σηµείων (εντολή Point) επί των καθισµάτων και 
σε απόσταση µεταξύ τους ίση µε το πλάτος των διαµηκών ενισχυτικών. 
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Ακολουθούν οι εντολές Blend και Extrude για την κατασκευή των ενισχυτικών που 
στηρίζουν τις θέσεις των κωπηλατών του κυρίου καταστρώµατος. 
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Συνεχίζουµε ακολουθώντας την ίδια διαδικάσία για να κατασκευάσουµε όλες τις 
στηρίξεις των θέσεων του κυρίου καταστρώµατος. 
 

 
 
Τέλος µε την εντολή Symmetry αναπαράγουµε το συµµετρικό µέρος της γάστρας 
στον υποκατάλογο « Συµµετρική γάστρα». 
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 3.2.5 ΥΠΕΡΥΨΩΜΕΝΟ ΚΑΤΑΣΤΡΩΜΑ ΚΑΙ ∆ΙΑ∆ΡΟΜΟΣ 
ΚΥΡΙΟΥ ΚΑΤΑΣΤΡΩΜΑΤΟΣ 

 
 

3.2.5.B1. Κατασκευή των κατακόρυφων εγκάρσιων ενισχυτικών του 
υπερυψωµένου καταστρώµατος 
 
Τα κατακόρυφα εγκάρσια ενισχυτικά του υπερυψωµένου καταστρώµατος, 
αποτελούνται από ζέυγη δύο ξεχωριστών ενισχυτικών. Η  ισαπόστασή τους είναι ίδια 
µε αυτή των κατακόρυφων ενισχυτικών των άλλων δύο κατώτερων καταστρωµάτων. 
Το ένα ενισχυτικό ξεκινά σαν  προέκταση του κατακόρυφου εγκάρσιου ενισχυτικού 
του 2ου καταστρώµατος και το άλλο ξεκινά από την εξωτερική επιφάνεια της γάστρας 
του σκάφους. Και  τα δύο καταλήγουν στο ίδιο ύψος. 
 
Χρησιµοποιούνται για την στήριξη του υπερυψωµένου καταστρώµατος. Το 
υπερυψωµένο κατάστρωµα προστατεύει τους κωπηλάτες και το πλήρωµα του 
σκάφους από τα καιρικά φαινόµενα. Επίσης το επάνω µέρος του έιναι επίπεδο για  
την χρήση του ως πρόσβαση στην περίπτωση επιθέσεως σε εχθρικό πλοίο (ρεσάλτο). 
 
Τα κατακόρυφα εγκάρσια ενισχυτικά του υπερυψωµένου καταστρώµατος 
κατασκεύζονται αρκετά εύκολα κάνοντας δύο φορές χρήση της εντολής Extrude. 
Επιλέγουµε την άνω ακµή του κατακόρυφου εγκάρσιου ενισχυτικού του 2ου 
εσωτερικού καταστρώµατος, για να προεκτείνουµε κατά την z διεύθυνση. 
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Στη συνέχεια προεκτείνουµε κατά την y διεύθυνση σε µήκος ίσο µε το πλάτος του 
ενισχυτικού έδρασης. 
 

 
 
Το ύψος των κατακόρυφων ενισχυτικών είναι τυχαίο. Αργότερα θα 
χρησιµοποιήσουµε το σχέδιο µέσης τοµής του σκάφους και κατάλληλο σχεδιαστικό 
εργαλείο για να εξασφαλίσουµε ότι τα ενισχυτικά σταµατούν όλα στο ίδιο ύψος. 
Επαναλαµβάνουµε την διαδικασία για όλα τα κατακόρυφα εγκάρσια ενισχυτικά του 
υπερυψωµένου καταστρώµατος. 
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Για να σχεδιάσουµε τα κατακόρυφα εγκάρσια ενισχυτικά, που η άκρη τους εφάπτεται 
εξωτερικά της γάστρας του σκάφους, επιλέγουµε κάθε φορά επίπεδο yz. Το επίπεδο 
αυτό  εφάπτεται στο αντίστοιχο εσωτερικό κατακόρυφο ενισχυτικό. Με τον τρόπο 
αυτό εξασφαλίζουµε ότι τα ζεύγη ενισχυτικών που στηρίζουν το υπερυψωµένο 
κατάστρωµα βρίσκονται  στο ίδιο επίπεδο yz. 
 
Στη συνέχεια µε χρήση των εντολών Sketch και  Spline σχεδιάζουµε την µορφή της 
στήριξης του υπερυψωµένου καταστρώµατος. Να σηµειωθεί ότι για την 
συγκεκριµένη σχεδίαση δεν υπάρχουν κατασκευαστικές λεπτοµέρειες. Συνεπώς 
δίνουµε µορφή στο ενισχυτικό κάνοντας χρήση µόνο φωτογραφιών.  
 

 
 
Σχεδιάζουµε νέα καµπύλη (εντολές Sketch και Spline), στο ίδιο επίπεδο µε την 
προηγούµενη και παράλληλα µετατοπισµένη για να δώσουµε στο κατακόρυφο 
εγκάρσιο ενισχυτικό το κατάλληλο πλάτος. 
 
Το ακραίο σηµείο της κάθε καµπύλης εισέρχεται εσωτερικά της γάστρας της 
Τριήρους. Στη συνέχεια µε χρήση της εντολής Split θα κόψουµε το ενισχυτικό ώστε 
αυτό να εφάπτεται εξωτερικά της γάστρας. 
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Οι καµπύλες που σχεδιάσαµε θα µας δώσουν επιφάνεια µε χρήση της εντολής Blend. 
Κατασκευάζουµε το κατακόρυφο ενισχυτικό στήριξης του υπερυψωµένου 
καταστρώµατος µε την εντολή Extrude (προεκτείνοντας κατά x ). 
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Επαναλαµβάνουµε την διαδικάσια που περιγράψαµε για όλα τα εξωτερικά εγκάρσια 
κατακόρυφα ενισχυτικά. 
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3.2.5.B2. Κατασκευή  του υπερυψωµένου καταστρώµατος 
 
Για την κατασκευή του υπερυψωµένου καταστρώµατος χρησιµοποιούµε πληροφορίες 
από το σχέδιο της µέσης τοµής της Τριήρους. Χαράσουµε βοηθητική ευθεία (µε την 
εντολή Line) στο xz επίπεδο και σε ύψος που έχουµε µετρήσει από το σχέδιο µέσης 
τοµής και είναι ίσο µε το ύψος του υπερυψωµένου καταστρώµατος. Επιλέγουµε την 
εντολή Extrude και φέρουµε επιφάνεια στο xy επίπεδο µέχρι αυτή να τµήσει όλα τα 
κατακόρυφα εγκάρσια ενισχυτικά. 
 

 
 
Με την εντολή Split κόβουµε τα κατακόρυφα εγκάρσια ενισχυτικά του 
υπερυψωµένου καταστρώµατος εξασφαλίζοντας συγχρόνως ότι όλα βρίσκονται στο 
ίδιο ύψος. 
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Στην συνέχεια χρησιµοποιούµε την ακµή του ενισχυτικού του κυρίου καταστρώµατος 
για να χαράξουµε καµπύλη ίδιας µορφής µε την εντολή 3D Curve Offset. Η καµπύλη 
µεταφέρεται κατα την y διεύθυνση µέχρι το εξωτερικό ίχνος του υπερυψωµένου 
καταστρώµατος. 
 

 
 
Με την εντολή Extrude  κατά την z διεύθυνση φέρουµε επιφάνεια έως ότου αυτή 
τµήσει την επιφάνεια του υπερυψωµένου καταστρώµατος. 
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Χρησιµοποιούµε την εντολή Split για να κόψουµε την επιφάνεια του υπερυψωµένου 
καταστρώµατος. 
 

 
 
 
Στη συνέχεια µε χρήση της κάτοψης του σχεδίου γενικής διάταξης της Τριήρους 
διαµορφώνουµε την επιφάνεια του υπερυψωµένου καταστρώµατος. 
 
Επιλέγουµε ως επίπεδο σχεδίασης την επιφάνεια του υπερυψωµένου καταστρώµατος. 
Κάνουµε πολλαπλή και κατάλληλη  χρήση των εντολών: 
 
Positioned Sketch, Spline και Line για σχεδιάσουµε σκαριφίµατα σε κάτοψη, της 
εντολής Extrude για να φέρουµε τις επιφάνειες των σκαριφιµάτων (σε z διεύθυνση) 
που τέµνουν την επιφάνεια του υπερυψωµένου καταστρώµατος και της εντολής Split 
για να κόψουµε και να επιτύχουµε την τελική διαµόρφωση του υπερυψωµένου 
καταστρώµατος. 
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Κόβουµε  το υπερυψωµένο κατάστρωµα στο σωστό µήκος,  στο πρυµναίο µερος : 
 

 
 
και στη συνέχεια στο πρωραίο µέρος :  
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Σχεδιάζουµε την διαµόρφωση του πρωραίου τµήµατος εσωτερικά : 
 

 
 
 και στη συνέχεια του πρυµναίου τµήµατος : 
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Όµοια και για την οπή του πηδαλίου και έχουµε τελικά διαµορφώσει την επιφάνεια 
του υπερυψωµένου καταστρώµατος. 
 

 
 
Χρησιµοποιούµε την εντολή Extrude για να δώσουµε το απαραίτητο πάχος στην 
επιφάνεια του υπερυψωµένου καταστρώµατος. 
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Επιλέγουµε  τις ακµές της επιφάνειας του υπερυψωµένου καταστρώµατος και 
κάνουµε χρήση της εντολής Extrude δύο φορές για να κατασκευάσουµε το πλαϊνό 
περιφερειακό µέρος του υπερυψωµένου καταστρώµατος.  Αρχικά  προεκτείνουµε 
κατά την διεύθυνση z και στη συνέχεια κατά την διεύθυνση y. Ολοκληρώνουµε µε 
τον τρόπο αυτό την κατασκευή του υπερυψωµένου καταστρώµατος. 
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3.2.5.B3. Κατασκευή  του διαδρόµου του δεύτερου καταστρώµατος 
 
Για να κατασκευάσουµε τον κύριο διάδροµο της Τριήρους µέσω του οποίου οι 
κωπηλάτες µεταβαίνουν στις θέσεις τους πρέπει αρχικά να σχεδιάσουµε τις στηρίξεις 
του διαδρόµου. 
Η κατασκευή των διαµηκών ενισχύσεων του 2ου καταστρώµατος είναι αρκετά απλή 
και γίνεται µε χρήση γνωστών εντολών. 
Ενώνουµε µε την εντολή Line τα σηµεία των ακµών των εγκάρσιων ενισχυτικών του 
2ου καταστρώµατος και στην συνέχεια µε την εντολή Blend δηµιουργούµε επιφάνεια 
µεταξύ των ευθειών.  
  

 
 
Επιλέγουµε την εντολή Extrude και προεκτείνουµε κατά την διεύθυνση z για να 
κατασκεύασουµε το ενισχυτικό.  
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Η διαδικασία επαναλαµβάνεται µέχρι να κατασκευαστούν όλα τα διαµήκη ενισχυτικά 
στήριξης του διαδρόµου του 2ου καταστρώµατος. 
 

 
 
Ακριβώς µε τον ίδιο τρόπο εργαζόµαστε για την κατασκευή των εγκάρσιων 
στηρίξεων του διαδρόµου.  
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Επαναλαµβάνουµε για όλα τα εγκάρσια ενισχυτικά του διαδρόµου. 
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Ο κύριος διάδροµος της Τριήρους όπως φαίνεται και από το σχέδιο γενικής διάταξης 
σε κάτοψη, ακολουθεί το γεωµετρικό σχήµα  (σε κάτοψη) του υπερυψωµένου 
κατστρώµατος. 
 
Αυτός είναι και ο λόγος που κάποια από τα κατακόρυφα εγκάρσια ενισχυτικά του 
υπερυψωµένου καταστρώµατος στην πλώρη µεταφέρθηκαν κατά τον  y άξονα, µε 
χρήση της εντολής Translate. 
 

 
 
Η σχεδίαση δεν διαφέρει από εκέινη των στηρίξεων του διαδρόµου. Επιλέγουµε την 
εντολή Line για ενώσουµε µε ευθείες τις κάτω ακµές των κατακόρυφων ενισχυτικών. 
Αυτά όπως προαναφέραµε έχουν τοποθετηθεί στη σωστή θέση κατά το y. 
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Στη συνέχεια θα χρησιµοποιήσουµε την εντολή Join για ενώσουµε τις ευθείες µεταξύ 
τους ως εξής : 
 
Insert → Operations → Join → ok 
Εµφανίζεται το παράθυρο Join Definition 
 
Elements to join → κλίκ στις ευθείες που σχεδιάσαµε 
προηγουµένως 
Parameters  → µαρκάρουµε Check Tagency  και Check Connexity  
ok 

 

 
 
Με την εντολή Symmetry κατασκευάζουµε το συµµετρική καµπύλη. 
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Και φέρουµε την επιφάνεια µεταξύ των καµπυλών µε την εντολή Blend. Το 
απαραίτητο πάχος του διαδρόµου κατά z το δίδουµε µε την εντολή Extrude κατά τον 
γνωστό τρόπο. 
 

 
 
Όπως είναι φανερό η κατασκευή του τµήµατος του διαδρόµου που είναι παράλληλο 
δεν παρουσιάζει καµµιά δυσκολία. Ενώνουµε µε Line τις ακµές των κατακόρυφων 
ενισχυτικών, φέρουµε την επιφάνεια µε Blend και δίδουµε πάχος µε Extrude. 
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Για την κατασκευή του διαδρόµου στην πρύµνη εργαζόµαστε όπως και στην πλώρη. 
 

 
 
Ο κύριος διάδροµος της Τριήρους κατασκευάστηκε.  
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Σε κάθε τµήµα της σχεδίασης της Τριήρους, όπως εχουµε προαναφέρει, κάνουµε 
χρήση της εντολής Symmetry για να κατασκευάσουµε το συµµετρικό της µέρος. 
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3.2.6 ΠΛΩΡΗ ΤΗΣ ΤΡΙΗΡΟΥΣ 
 

 
3.2.6.B1. Κατασκευή του πρωραίου τµήµατος εµβολισµού και των 
ένισχυσεών του 
 
Οι Τριήρεις ήταν πολεµικά πλοία και ένας απο τους βασικούς τους ρόλους ήταν ο 
εµβολισµός των εχθρικών πλοίων.  Συνεπώς γίνεται εύκολα κατανοητό πως η 
κατασκευή της Τριήρους, όσο αφορά το πρωραίο τµήµα, ήταν αρκετά ενισχυµένη. 
 
Εµφανίζουµε το τµήµα της πλώρης που σχεδιάστηκε στην αρχή του κεφαλαίου, 
χρησιµοποιώντας την εντολή Hide/Show, το οποίο προσωρινά είχαµε ¨ κρύψει¨ για 
να δώσουµε έµφαση στην υπόλοιπη σχεδίαση. 
 

 
 
Αρχικά θα σχεδιάσουµε το εξωτερικό περίβληµα ενίσχυσης της γάστρας  της πλώρης 
το οποίο αποτελεί και την βάση στήριξης του εµβόλου. Η σχεδίαση θα βασιστεί σε 
πληροφορίες που προκύπτουν από φωτογραφίες καθώς και από το γεωµετρικό σχήµα 
που προκύπτει από την πλάγια όψη του σχεδίου γενικής διάταξης. 
 
Χρησιµοποιούµε το  σχέδιο του προφίλ του σκάφους και την εντολή Sketch σε xz 
επίπεδο για να δώσουµε την κατάλληλο γεωµετρικό σχήµα στο περίβληµα ενίσχυσης 
της πρώρας. 
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Επιλέγουµε την εντολή Spline για να χάράξουµε το επάνω µέρος του περιβλήµατος. 
 

 
 
Συνεχίζουµε µε την εντολή Projection για να προβάλουµε την καµπύλη πάνω στην 
γάστρα της Τριήρους. 
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Έχοντας την προβολή της καµπύλης πάνω στη γάστρα επιλέγουµε την εντολή Point 
για να δηµιουργήσουµε πλήθος σηµείων πάνω στην γάστρα. 
 

 
 
Στη συνέχεια σχεδιάζουµε καµπύλη που παρεµβάλλει τα σηµεία µε την εντολή 
Spline. 
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Και επιλέγουµε το τελευταίο σηµείο της καµπύλης και το ακραίο σηµείο της τρόπιδας 
για να φέρουµε ευθεία µε την εντολή Line. 
 

 
 
Κατόπιν σχεδιάζουµε την επιφάνεια του περιβλήµατος µε την εντολή Fill ως εξής  
 
Insert → Surfaces → Fill → ok 
Εµφανίζεται το παράθυρο Fill Surface  Definition 
 
Boundary → κλίκ στις καµπύλες  που σχεδιάσαµε 
προηγουµένως και στις ακµές της γάστρας  
Ok 
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Συνεχίζοντας κατασκευάζουµε την κάτω επιφάνεια του περιβλήµατος ενίσχυσης της 
πρώρας µε χρήση της εντολής Blend. Επιλέγουµε την κάτω ακµή της άνω επιφάνειας 
ενίσχυσης και την κάτω ακµή της τρόπιδας του σκάφους. 
 

 
 
Ολοκληρώνουµε την σχεδίαση του εξωτερικού περιβλήµατος της πρώρας 
χρησιµοποιώντας την εντολή Split για να κόψουµε την επιφάνεια που δεν χρειάζεται.  
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Σχεδιάζουµε στη συνέχεια το συµµετρικό µέρος του περιβλήµατος µε την εντολή 
Symmetry και χρησιµοποιούµε την εντολή Blend για κλείσουµε  τις δύο 
συµµετρικές επιφάνειες. 
 

 
 
Το εξωτερικό µέρος της γάστρας της πρώρας, που χρησιµοποιείται για την ενίσχυση 
του σκάφους κατά τους εµβολισµούς, κατασκευάστηκε. 
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3.2.6.B2. Κατασκευή του συµβολικού µατιού της πλώρης 
 
Στην πλώρη της Τριήρους ήταν ζωγραφισµένο ένα µάτι µε συµβολική σηµασία. 
Πρόσεχε την πορεία και αποµάκρυνε τα κακά πνεύµατα που θα µπορούσαν να 
βάλουν σε κίνδυνο το ταξίδι. 
 
Αρχικά χρησιµοποιούµε την εντολή Point για να δηµιουργήσουµε πλήθος σηµείων 
πάνω στο εξωτερικό περίβληµα ενίσχυσης της πλώρης. Αυτά τοποθετούνται µε 
τέτοιο τρόπο ώστε να σχηµατίζουν το περίγραµµα του µατιού. 
 

 
 
Επιλέγουµε την εντολή Spline για να σχεδιάσουµε καµπύλες που παρεµβάλλουν τα 
σηµεία. 
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Ενώνουµε τις καµπύλες µε την εντολή Join και σχηµατίζουµε την επιφάνεια µε την 
εντολή Fill . ∆ίδουµε το απαραίτητο πάχος µε την εντολή Extrude. 
 

 
 
Όµοια εργαζόµαστε για την σχεδίαση του εσωτερικού του µατιού. Κάθε φορά µε 
χρήση της εντολής  Properties → Color  επιλέγουµε το κατάλληλο χρώµα 
που του δίνει ρεαλιστική όψη. 
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3.2.6.B3. Κατασκευή του µπρούτζινου εµβόλου της πλώρης 
 
Το µπρούτζινο έµβολο προεξείχε του πρόσθιου τµήµατος προς ενίσχυση της πλώρης. 
Χρησίµευε για να προκαλεί ρήγµατα στα εχθρικά πλοία στις ναυµαχίες. 
 
Το σχήµα του εµβόλου είχε διαφοροποιήσεις από σκάφος σε σκάφος ανάλογα µε τις 
προσωπικές προτιµήσεις του κατασκευαστή ναυπηγού.  
 
Οι φωτογραφίες και το σχέδιο γενικής διάταξης της Τριήρους βοήθησαν στην 
σχεδίαση του εµβόλου. 
 
Επιλέγουµε επίπεδο σχεδίασης xz και την εντολή Sketch για να σχεδιάσουµε το 
προφίλ του πίσω µέρους του εµβόλου.  
 

 
 
Στη συνέχεια προβάλλουµε µε την εντολή Projection πάνω στο περίβληµα ενίσχυσης 
της πλώρης. 
 
Χρησιµοποιούµε νέο Sketch και προβάλλουµε ξανά για να ολοκληρώσουµε το πίσω 
µέρος της σχεδίασης του εµβόλου. 
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Επιλέγουµε την εντολή Blend για να φέρουµε την επιφάνεια µεταξύ των καµπυλών 
και την εντολή Extrude για να δώσουµε το κατάλληλο πάχος κατά την y διεύθυνση. 
 

 
 
Έχουµε εξασφαλίσει την εφαρµογή του πίσω µέρους του εµβόλου πάνω στο 
εξωτερικό περίβληµα ενίσχυσης της πλώρης. 
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Το µπρούτζινο κέλυφος του εµβόλου το οποίο βρίσκεται εξωτερικά της ξύλινης 
εµπρόσθιας ενίσχυσης σχεδιάζεται µε επαναλαµβανόµενη χρήση της εντολής Blend. 
Σαν όρια των επιφανειών επιλέγουµε  ακµές που περικλείουν την επιφάνεια που 
θέλουµε να σχεδιάσουµε. Σε κάθε περίπτωση δίδουµε το απαιτούµενο πάχος στο 
κέλυφος µε την εντολή Extrude. 
 

 
 
 
Για να κατασκευάσουµε τους µεταλλικούς  ύλους που συγκρατούν το κέλυφος του 
εµβόλου πάνω στο ξύλινο περίβληµα ενίσχυσης της πλώρης εργαζόµαστε ως εξής: 
 
∆ηµιουργούµε µε την εντολή Point σηµείο πάνω στην επιφάνεια του κελύφους του 
εµβόλου.  
 
Επιλέγουµε την εντολή Circle και φέρουµε τον κύκλο που έχει κέντρο το 
προηγούµενο σηµέιο και εφάπτεται στην επιφάνεια του κελύφους. 
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Στη συνέχεια σχηµατίζουµε την επιφάνεια που περικλείει ο κύκλος µε την εντολή Fill 
και κατασκευάζουµε τον ύλο χρησιµοποιώντας την εντολή Extrude. 
 

 
 
και επαναλαµβάνουµε την διαδικασία για όλους τους ύλους. 
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Στη συνέχεια θα σχεδιάσουµε τις µεταλλικές διαµήκεις ενισχύσεις που προεξέχουν 
δεξιά και αριστερά του κελύφους του εµβόλου. Χρησιµεύουν στην ευκολότερη 
διάρηξη των εχθρικών σκαφών καθώς  και στην ευκολότερη απεµπλοκή της 
Τριήρους από την γάστρα του εχθρικού σκάφους. 
Επιλέγουµε την εντολή Sketch και σχεδιάζουµε καµπύλο τµήµα στο xz επίπεδο όπως 
φαίνεται πιο κάτω : 
 

 
 
Οµοίως σχεδιάζουµε καµπύλο τµήµα στο xy επίπεδο 
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Ο συνδυασµός των καµπυλών θα δώσει την επιθυµητή καµπύλη της διαµήκους 
ενίσχυσης του εµβόλου. Εργαζόµαστε ως εξής : 
 
Insert → Wireframe → Combine → ok 
Εµφανίζεται το παράθυρο Combine  Definition 
Combine type → normal 
Curve 1 → κλίκ στην καµπύλη του πρώτου Sketch 
Curve 2 → κλίκ στην καµπύλη του δεύτερου Sketch  
Ok 
 

 
 
Χρησιµοποιούµε την εντολή Symmetry για να σχεδιάσουµε την συµµετρική της και 
την εντολή Blend για να φέρουµε την µεταξύ τους επιφάνεια. 
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Κατασκευάζουµε το διαµήκες ενισχυτικό δίνωντας το απαραίτητο πάχος µε την 
εντολή Extrude και στη συνέχεια επιλέγουµε το χρώµα. 
 

 
 
Η ίδια διαδικασία ακολουθείται και για την σχεδίαση των άλλων δύο ενισχυτικών. Η 
σχεδίαση ολοκληρώνεται µε δύο διακοσµητικές λεπτοµέρειες µεταξύ των 
ενισχυτικών. Η σχεδιασή τους δεν διαφέρει από εκείνη του µατιού και για το λόγο 
αυτό παρουσιάζονται µόνο γραφικά. 
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3.2.6.B4. Τελική διαµόρφωση της πλώρης και κατασκευή των 
πρωραίων θέσεων παρατήρησης 
 
Αρχικά θα κατασκευάσουµε την προέκταση του κυρίου διαδρόµου της Τριήρους, η 
οποία οδηγεί στις θέσεις παρατηρήσεως του σκάφους. Επειδή η πλώρη βρίσκεται 
ψηλότερα από τον κύριο διάδροµο του σκάφους, η προέκταση έχει την µορφή 
σκάλας. 
Η σχεδίαση γίνεται µε γνωστό τρόπο χρησιµοποιώντας την εντολή Extrude. 
Επιλέγουµε την τελευταία ακµή του πρωραίου τµήµατος του διαδρόµου και 
προεκτείνουµε κατά την z διεύθυνση, στη συνέχεια την άνω ακµή της επιφάνειας που 
µόλις σχεδιάσαµε και προεκτείνουµε κατά x, στη συνέχεια κατά z και 
επαναλαµβάνουµε έως ότου να σχηµατιστεί η σκάλα. 
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Συνεχίζουµε µε την σχεδίαση των ενισχυτικών του κυρίου καταστρώµατος που 
βρίσκονται στην πλώρη. Η σχεδιάση τους γίνεται ακριβώς µε τον ίδιο τρόπο που 
κατασκευάσαµε το κεντρικό ενισχυτικό του κυρίου καταστρώµατος και για το λόγο 
αυτό θα παρουσιαστούν µόνο γραφικά. 
 

 
 
Η σκάλα που  σχεδιάσαµε πρίν οδηγεί σε ειδικούς χώρους επί του καταστρώµατος 
της πλώρης που προεξέχουν δεξιά και αριστερά του σκάφους. 
Αυτοί έχουν πολλαπλή χρήση. Χρησιµοποιούνται για την ρήψη και φύλαξη των 
αγκυρών της Τριήρους. 
 Επίσης λόγω της θεσεώς τους χρησιµοποιούνται για την παρατήρηση του όριζοντα 
καθώς και την επίβλεψη του σκάφους στο πλαϊνό του µέρος.  
Τέλος σε περίπτωση επιθέσεως σε εχθρικό πλοίο χρησιµοποιούνται από τους 
τοξοβόλους ως πρόσβαση για να εκτοξεύσουν τα βέλη τους. 
 
Η σχεδίαση θα στηριχτεί σε πληροφορίες που πέρνουµε από την πλάγια όψη του 
σχεδίου γενικής διάταξης της Τριήρους καθώς και από φωτογραφικό υλικό. 
 
Επιλέγουµε xz επίπεδο σχεδίασης και χρησιµοποιούµε την εντολή Sketch. Ακολουθεί 
η χρήση των  εντολών Line και Circle, κατά τα γνωστά, για να κατασκευάσουµε το 
προφίλ της πρωραίας θέσεως παρατήρησης. 
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∆ηµιουργούµε νέο Sketch ίδιας µορφής, εσωτερικά του πρώτου, στο xz επίπεδο. Με 
τον τρόπο αυτό ολοκληρώνουµε το περίγραµµα και µε χρήση της εντολής Fill  
κατασκευάζουµε την επιφάνεια του περιγράµµατος. Η σχεδίαση του εξωτερικού 
τµήµατος της θέσεως παρατηρήσεως της πλώρης τελειώνει µε χρήση της εντολής 
Extrude και προέκταση κατά τον y άξονα. 
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Στη συνέχεια σχεδιάζουµε το σκέπαστρο της πλώρης όπως αυτό φαίνεται στην 
κάτοψη του σχεδίου γενικής διάταξης της Τριήρους. Επιλέγουµε το xy επίπεδο και 
φέρουµε την άνω ακµή του σκεπάστρου µε χρήση των εντολών Sketch και Spline. 
 

 
 
Η καµπύλη που σχεδιάσαµε µεταφέρεται στο σωστό z µε την εντολή Translate. 
Κόβουµε το τµήµα που δεν χρειάζεται µε την εντολή Split και χρησιµοποιούµε δύο 
φορές την εντολή Extrude για να κατασκευάσουµε το πλαϊνό µέρος του σκεπάστρου. 
Μία φορά για να προεκτείνουµε προς τα κάτω έως το σωστό z και άλλη µία για να 
δώσουµε το απαιτούµενο πάχος. 
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Έχοντας  το περίγραµµα της θέσεως παρατηρήσεως καθώς και το πλαϊνό τµήµα του 
σκεπάστρου µε πολλαπλή χρήση των εντολών Blend, Extrude και Split µπορούµε 
εύκολα και µε µεθόδους που έχουν περιγραφεί αναλυτικά να κατασκευάσουµε τις 
µεταξύ τους επιφάνειες και συνεπώς το χώρο που περικλείουν.   
 

 
 
Στο µπροστινό µέρος της θέσεως παρατηρήσεως βρίσκεται  η οπή µέσα από την 
οποία διέρχεται η άγκυρα του σκάφους. Αυτή σχεδιάζεται αρχικά µε επιλογή της 
εντολής Point για να ορίσουµε την θέση της, της εντολής Circle για να ορίσουµε την 
διαµετρό της και των εντολών Extrude και Split για να για να δώσουµε την τελική 
της µορφή. 
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Με χρήση αποκλειστικά φωτογραφικού υλικού, σχεδιάζουµε κατασκευαστικές 
λεπτοµέρειες που αφορούν την ενίσχυση της ξύλινης επένδυσης της θέσεως 
παρατηρήσεως.  
 
Ο λόγος είναι για να µην προκαλούνται φθορές στην ξύλινη επένδυση κατά την ρήψη 
της άγκυρας. 
 
Η σχεδίαση γίνεται µε χρήση της εντολής Positioned Sketch επί της επιφάνειας της 
θέσεως παρατηρήσεως και δεν παρουσιάζει κάποιο ιδιαίτερο ενδιαφέρον. Για αυτό 
τον λόγο την παρουσιάζουµε µόνο γραφικά. 
 

 
 
 
Η διαµόρφωση της πλώρης ολοκληρώνεται µε χρήση της εντολής Symmetry για 
κάθε ένα κατασκευστικό µέρος της πλώρης που σχεδιάσαµε ώστε να εµφανίσουµε το 
συµµετρικό του. 
 
Τέλος σχηµατίζουµε την επιφάνεια µεταξύ των πλαϊνών µερών του σκεπάστρου µε 
την εντολή Blend.  
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Παρουσιάζουµε γραφικά την τελική µορφή της  πλώρης της Τριήρους : 
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3.2.7 ΠΡΥΜΝΗ ΤΗΣ ΤΡΙΗΡΟΥΣ 
 
 
3.2.7.B1. Κατασκευή των πρυµναίων ενισχύσεων του κυρίου 
καταστρώµατος 
 
Για την σχεδίαση του διαµήκους ενισχυτικού του κυρίου καταστρώµατος θα 
εργαστούµε όπως και στην κατασκευή του κεντρικού και πρωραίου τµήµατος. 
 Με την διαφορά ότι κατά την χρήση της εντολής Extrude δεν προεκτείνουµε µέχρι η 
άκρη του πρωραίου τµήµατος να συµπέσει µε εκείνη του κεντρικού τµήµατος. 
Σταµατάµε περίπου στο µισό πάχος ώστε να υπάρξει ο διαθέσιµος χώρος επί του 
κυρίου καταστρώµατος να στηριχθούν οι εγκάρσιες  ενισχύσεις όπως θα δούµε 
παρακάτω. 
 

 
 
Στη συνέχεια κατασκευάζουµε το διαµήκες ενισχυτικό (κάγκελο) που ενώνει το 
ακροστόλιο (ουρά)  της Τριήρους µε το πρυµναίο τµήµα του υπερυψωµένου 
καταστρώµατος. Επειδή το ενισχυτικό που θέλουµε να κατασκευάσουµε 
µεταβάλλεται και στις τρείς διαστάσεις θα χρησιµοποιήσουµε την εντολή Combine, 
αφού πρώτα µε την εντολή Sketch έχουµε σχεδιάσει τις καµπύλες που πρόκειται να 
συνδυαστούν.  
 
Συνεπώς σχεδιάζουµε δύο καµπύλες, µια στο xz επίπεδο και µία xy επίπεδο 
λαµβάνοντας υπ’όψιν µας το σχέδιο γενικής διάταξης της Τριήρους. 
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Στη συνέχεια επί της καµπύλης που φέραµε δηµιουργούµε σηµεία µε την εντολή 
Point. Επίσης δηµιουργούµε τα  σηµεία στήριξης του ενισχυτικού. Τέλος 
σχεδιάζουµε την καµπύλη που τα παρεµβάλλει µε την εντολή Spline. 
 

 
 
Κατασκευάζουµε το διάµηκες ενισχυτικό µε διπλή χρήση της εντολής Extrude.  
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Όπως αναφέραµε και στην αρχή το διαµήκες ενισχυτικό που σχεδιάστηκε στηρίζεται 
πάνω στην επιφάνεια του κυρίου καταστρώµατος µε κατακόρυφες εγκάρσιες 
ενισχύσεις. 
 
Επιλέγουµε την εντολή Point και φέρουµε σηµεία στις θέσεις που εδράζονται τα 
κατακόρυφα ενισχυτικά. 
 
 Στη συνέχεια µε την εντολή Line φέρουµε ευθείες κατά τον z άξονα έως ότου 
τµήσουν την επιφάνεια του κυρίου καταστρώµατος.  
 
Κατόπιν κατασκευάζουµε τα ενισχυτικά µε διπλή χρήση της εντολής Extrude και 
αφαιρούµε το µέρος που δεν χρειάζεται µε την εντολή Split.  
 
Επαναλαµβάνουµε τα ίδια και για τις τρείς κατακόρυφες στηρίξεις. 
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3.2.7.B2. Κατασκευή του ακροστολίου της Τριήρους 
 
Η πρύµνη τελείωνε στο ακροστόλιο που ήταν διακοσµητικό στοιχείο µε 5 ή 6 
κυρτούς άξονες, σαν βεντάλια. Οι αρχαίοι ήθελαν το πλοίο να µοιάζει µε θαλάσσιο 
τέρας. Το ακροστόλιο ήταν η ουρά του τέρατος που έβγαινε από την θάλασσα. 
 
Οι κυρτοί άξονες του ακροστολίου κατασκευάζονται µε χρήση της εντολής Combine 
όπως κατασκευάσαµε και προηγουµένως το διαµήκες ενισχυτικό της πρύµνης. 
 
∆ηλαδή µε χρήση της εντολής Sketch σχεδιάζουµε αρχικά το προφίλ του κυρτού 
άξονα στο xy επίπεδο και στη συνέχεια στο xz επίπεδο. 
 
Ο συνδυασµός των καµπυλών θα µας δώσει την ακµή του κυρτού άξονα.  
 
 Να σηµειωθεί ότι για την συγκεκριµένη σχεδίαση δεν διαθέταµε καµµία 
κατασκευαστική λεπτοµέρεια παρά µόνο φωτογραφικό υλικό.  
 

 
 
 
Με διπλή χρήση της εντολής Extrude θα του δώσουµε το απαιτούµενο ύψος και 
πάχος όπως παρουσιάζεται πιο κάτω : 
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Όµοια εργαζόµαστε για να κατασκευάσουµε τους υπόλοιπους κυρτούς άξονες του 
ακροστολίου καθώς και τους συµµετρικούς τους µε χρήση της εντολής Symmetry. 
 

 
 
Οι κυρτοί άξονες του ακροστολίου συγκρατιούνται µεταξύ τους µε ένα εγκάρσιο 
ευθύ ενισχυτικό στη βάση τους και από δύο κυρτούς άξονες στο πάνω µέρος τους. Η 
σχεδίαση των ενισχυτικών δεν διαφέρει από τα προηγούµενα. Η όλη κατασκευή είναι 
υλωµένη στο πιο ακραίο σηµείο της πρύµνης. 
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Στο ακροστόλιο περιλαµβάνεται και η προέκταση της καρίνας της Τριήρους η οποία 
εδράζεται στους ίδιους κυρτούς άξονες που στηρίζουν την ¨βεντάλια¨. Επίσης, η 
προέκταση στηρίζει το δοκάρι της σηµαίας του σκάφους. 
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Για την σχεδιασή της χρησιµοποιούµε επίπεδο το οποίο εφάπτεται της επιφάνειας του 
τελευταίου σηµείου της τρόπιδας επιλέγοντας την εντολή Plane. Στη συνέχεια µε την 
εντολή Posiotioned Sketch σχεδιάζουµε το περίγραµµα της προέκτασης της 
τρόπιδας. 
 

 
 
Θέλοντας να δώσουµε την κατάλληλη κυρτότητα στο περίγραµµα που σχεδιάσαµε, 
χαράσουµε καµπύλη στο xz επίπεδο σε άλλο Sketch και χρησιµοποιούµε την εντολή 
Combine. 
 

 
 



 138 

Φέρουµε την επιφάνεια του περιγράµµατος της προέκτασης της τρόπιδας µε την 
εντολή Fill  και δίδουµε το κατάλληλο πάχος µε την εντολή Extrude. 
 
 

 
 
Όπως είναι φανερό το µήκος της  προέκτασης της τρόπιδας δεν είναι αρκετό για να 
στηριχθεί πάνω στους κυρτούς άξονες της βεντάλιας, για το λόγο αυτό κάνουµε 
χρήση της εντολής Affinity  ως εξής : 
 
Insert → Operations →  Affinity → ok 
Εµφανίζεται το παράθυρο Afiinity Definition 
 
Element → κλίκ στην προέκταση της τρόπιδας 
Origin → σηµείο στη µέση της κάτω ακµής της προέκτασης  
x → 2 (2 φορές το αρχικό µήκος) 
y → 1.1 (1.1 φορές το αρχικό πλάτος) 
z → 1 (το ίδιο ύψος) 
ok 
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Συνεπώς καθορίσαµε τον αφφινικό µετασχηµατισµό και στις τρείς διαστάσεις και 
τελικά πέρνουµε την  επιθυµητή προέκταση της τρόπιδας όπως φαίνεται παρακάτω : 
 

 
 
Στη συνέχεια θα κατασκεύασουµε τον κύλινδρο στον οποίο στηρίζεται το δοκάρι της 
σηµαίας. 
 
 ∆ηµιουργούµε σηµείο,µε την εντολή Point, στη θέση που διέρχεται ο κύλινδρος και 
στην συνέχεια µε αρχή αυτό το σηµείο φέρουµε ευθεία, µε την εντολή Line, σε 
διεύθυνση ίδια µε εκείνη του κυλίνδρου που θέλουµε να κατασκευάσουµε.  
 
Ο ζητούµενος κύλινδρος κατασκευάζεται µε χρήση της εντολής Cylinder  ως εξής : 
 
Insert → Surfaces →  Cylinder → ok 
Εµφανίζεται το παράθυρο Cylinder Surface Definition 
 
Point → κλίκ στο προηγούµενο σηµείο  
Direction → κλίκ στην προηγούµενη ευθεία 
Radius → πληκτρολογούµε την διάµετρο που επιθυµούµε 
Limit 1 → µε πατηµένο το δεξί κλίκ µετακινούµε το όριο 
µέχρι αυτό να πακτωθεί στην τρόπιδα 
Limit 2 → µε πατηµένο το δεξί κλίκ µετακινούµε το όριο 
µέχρι αυτό να ξετρυπήσει το πάνω µέρος της ενίσχυσης του 
ακροστολίου 
ok 
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Τέλος κάνουµε χρήση της εντολής Split για να αφαιρέσουµε το τµήµα της ενίσχυσης 
του ακροστολίου από το οποίο διέρχεται ο κύλινδρος στήριξης της σηµαίας. Η 
κατασκευή του ακροστολίου της Τριήρους ολοκληρώθηκε. 
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3.2.7.B3. Κατασκευή του ανώτερου καταστρώµατος της πρύµνης της 
Τριήρους 
 
Το ανώτερο κατάστρωµα της πρύµνης αποτελούσε τη θέση επιβιβάσεως-
αποβιβάσεως του πληρώµατος. Η επιβίβαση-αποβίβαση συνήθως γινόταν µε χρήση 
ξύλινων σκαλών οι οποίες στηρίζονταν στο πλαϊνό µέρος του σκάφους δεξιά και 
αριστερά της γάστρας. Αρκετές φορές οι σκάλες µεταφέρονταν κατά το ταξίδι και 
δένονταν δεξιά και αριστερά του σκάφους στα διαµήκη πρυµναία ενισχυτικά 
(κάγκελα). 
 
Το ανώτερο κατάστρωµα της πρύµνης, το οποίο αποτελεί προέκταση του κυρίως 
διαδρόµου του 2ου καταστρώµατος της Τριήρους, σχεδιάζεται αρκετά έυκολα ως εξής  
 
Χρησιµοποιούµε την εντολή Blend για να φέρουµε την επιφάνεια του ανώτερου 
καταστρώµατος της πρύµνης η οποία εκτείνεται από την µία πλευρά της γάστρας του 
σκάφους έως την άλλη. ∆ίδουµε το απαραίτητο πάχος στην επιφάνεια µε την εντολή 
Extrude κατά την z διεύθυνση. 
 
Τα κατακόρυφα ενισχυτικά που θα στηρίξουν το ανώτερο κατάστρωµα σχεδιάζονται 
σύµφωνα µε τα προαναφερθέντα. Στην περίπτωση που αυτά δεν έχουν το κατάλληλο 
ύψος για να ακουµπήσουν στο κάτω µέρος του καταστρώµατος, ενεργούµε ως εξής : 
 
Πατάµε δεξί κλίκ στο κατακόρυφο ενισχυτικό που επιθυµούµε. Στην συνέχεια 
αριστερό κλίκ και επιλέγουµε   Extrude object  → Deinition → ok . 
 
Εµφανίζεται το παράθυρο Extrude Definition. 
 
Κρατώντας πατηµένο το αριστερό κλίκ πάνω στο όριο προέκτασης του ενισχυτικού, 
µετακινούµε προς τα επάνω µέχρι αυτό να τµήσει την επιφάνεια του καταστρώµατος. 
 
 Αφαιρούµε το µέρος του ενισχυτικού που δεν χρειάζεται µε χρήση της γνωστής 
εντολής Split εξασφαλίζοντας µε αυτό τον τρόπο την εφαρµογή του ενισχυτικού στη 
κάτω πλευρά του καταστρώµατος.  
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Και µε αυτό το τρόπο ολοκληρώθηκε η σχεδίαση του ανώτερου καταστρώµατος της 
πρύµνης.  
 

 
 
Τελειώνουµε την περιγραφή της κατασκευής και διαµόρφωσης της πρύµνης, 
έµφανίζοντας το συµµετρικό µέρος της γάστρας ώστε να έχουµε µια πληρέστερη 
εικόνα του γεωµετρίκου σχήµατος της Τριήρους ως αυτό το σηµείο. 
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3.2.8 ΙΣΤΙΑ 
 
Η Τριήρης χρησιµοποιούσε ως βοηθητικό µέσο  πανιά για την κινησή της, µόνο σε 
περίπτωση ούριου ανέµου. Αυτά στηρίζονταν πάνω σε δύο κεντρικά ιστία.  
 
Ο µεγάλος ιστός βρισκόταν στο µέσο του σκάφους και ο µικρός που είχε την 
ονοµασία ακάτιος ήταν κεκλιµένος και πρώραθεν του µεγάλου ιστού.  
 
3.2.8.B1. Κατασκευή του κύριου (µεγάλου)  ιστού της Τριήρους 
 
Για την κατασκευή του κεντρικού ιστίου της Τριήρους χρησιµοποιήσαµε 
φωτογραφικό υλικό το οποίο συλλέξαµε από το αντίγραφο του σκάφους που υπάρχει 
στην µαρίνα Φλοίσβου. 
 
Το ιστίο είχε την δυνατότητα να αφαιρείται από την βάση του και να τοποθετείται 
κατά µήκος του κυρίου διαδρόµου της Τριήρους. 
 
Συνεπώς αρχικά θα κατασκευάσουµε την βάση στήριξης του κεντρικού ιστίου της 
Τριήρους. Η τελευταία βρισκόταν πακτωµένη στον κύριο διάδροµο της Τριήρους στο 
µέσο του σκάφους. 
 
Επιλέγουµε την εντολή Line και φέρουµε ευθεία που εφάπτεται στο επίπεδο του 
διαδρόµου και έχει µήκος ίσο µε το πλάτος της βάσης στηρίξεως κατά την y 
διεύθυνση. 
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Στη συνέχεια χρησιµοποιούµε δύο φορές την εντολή Extrude για να δώσουµε ύψος 
και πάχος στην ¨πλάτη¨ στήριξης της βάσεως του ιστίου. 
 

 
 
Κατόπιν επιλέγουµε την εσωτερική κατακόρυφη ακµή της ¨πλάτης¨ στήριξης της 
βάσεως και χρησιµοποιούµε ξανά δύο φορές την εντολή Extrude για να 
κατασκευάσουµε το πλαϊνό µέρος της βάσης. 
 

 
 
Και µε την εντολή Symmetry χαράσουµε το συµµετρικό πλαϊνό µέρος. 
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Στο xz επίπεδο σχεδιάζουµε  ζεύγος ευθειών µε την εντολή Sketch.  
 

 
 
Το ζεύγος ευθειών µε την εντολή Extrude κατά την y διεύθυνση γίνεται ζέυγος 
επιπέδων µε τα οποία θα διαµορφώσουµε την βάση στηρίξεως. 
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Στη συνέχεια επιλέγουµε την εντολή Split και αφαιρούµε το τµήµα της βάσης που 
δεν χρειάζεται. 
 

 
 
Το κύριο ιστίο που στο µεγαλύτερο τµήµα του είναι κυλινδρικής διατοµής στην βάση 
του είναι ορθογωνικής διατοµής. Ο λόγος είναι ότι η συγκράτηση του ιστίου στη 
θέση του µετά την εφαρµογή δυνάµεων και πιέσεων λόγω ανέµων είναι πολύ 
καλύτερη όταν είναι ορθογωνικής διατοµής. Για να κατασκευάσουµε την βάση του 
κύριου ιστίου επιλέγουµε την εσωτερική εγκάρσια ακµή της ¨πλάτης¨ της βάσης 
στηρίξεως και χρησιµοποιούµε δύο φορές την εντολή Extrude όπως προηγουµένως. 
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Κατόπιν στο µέσο του πάνω µέρους της βάσεως στηρίξεως δηµιουργούµε σηµείο µε 
την εντολή Point. Στη συνέχεια κύκλο µε κέντρο το προηγούµενο σηµείο και 
διάµετρο ίση µε αυτή του κεντρικού ιστίου µε την εντολή Circle. 
 

 
 
Με σηµείο εκκίνησης το κέντρο του κύκλου χαράσουµε ευθεία (εντολή Line) κατά 
την z διεύθυνση και µήκος ίσο µε το ύψος του κεντρικού ιστίου. 
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Συνεχίζοντας επιλέγουµε ξανά την εντολή Circle σε xy επίπεδο για να καθορίσουµε 
την διάµετρο του άνω τµήµατος του ιστίου και µε την εντολή Blend φέρουµε την 
επιφάνεια του ιστίου. 
 

 
 
Με ταυτό το τρόπο σχεδιάστηκε ο βασικός κορµός του ιστίου. Έπειτα επιλέγουµε xy 
επίπεδο και κάνοντας χρήση της εντολής Sketch σχεδιάζουµε το περίγραµµα του 
µεταλλικού συνδέσµου συγκράτησης του κορµού του ιστίου εσωτερικά της βάσεως 
στηρίξεως. 
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Από το περίγραµµα φέρουµε την επιφάνεια µε την εντολή Fill  και κατασκευάζουµε 
τον σύνδεσµο συγκράτησης µε την εντολή Extrude µε προέκταση κατά την z 
διεύθυνση. Οι ύλοι συγκράτησης κατασκευάζονται µε τον ίδιο τρόπο που 
περιγράφηκε προηγουµένως. 
 

 
 
Τα µικρότερα εγκάρσια ιστία τα οποία στηρίζονται πάνω στον κύριο κορµό και 
συγκρατούν τα πανιά της Τριήρους σχεδιάζονται ως εξής : 
 
Στο yz επίπεδο επιλέγουµε την εντολή Sketch και χαράσουµε ευθεία µε µήκος όσο 
του ιστίου. 
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Κατόπιν µε διπλή χρήση της εντολής Circle σχεδιάζουµε κύκλους στα άκρα της 
ευθείας επιλέγοντας την σωστή διάµετρο. 
 

 
 
Με όρια τους κύκλους κατασκευάζουµε το εγκάρσιο ιστίο µε την εντολή Blend  και 
µε την εντολή Translate το µεταφέρουµε κατά τον x άξονα µέχρι να τµήσει τον 
κεντρικό κορµό. 
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Στη συνέχεια διαµορφώνουµε το άκρο του ιστίου που βρίσκεται πιο κοντά στον 
κεντρικό κορµό µε τέτοιο τροπο, ώστε να διευκολύνεται η συγκρατησή του µε το 
συµµετρικό του. 
 
Σε yz επίπεδο µε την εντολή Sketch φέρουµε ευθεία  
 

 
 
η οποία µε την εντολή Extrude θα µας δώσει το επίπεδο τοµής του εγκάρσιου ιστίου. 
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Κόβουµε το ιστίο µε την εντολή Spilt και γεµίζουµε την επιφάνεια του σηµείου 
τοµής µε την εντολή Fill . Φέρουµε και το συµµετρικό του µε χρήση της εντολής 
Symmetry.  
 

 
 
Στην κορυφή του κεντρικού κορµού αλλά και στις άκρες των εγκάρσιων ιστίων 
υπάρχουν µεταλλικοί οµόκεντροι κύλινδροι που χρησιµεύουν για το δέσιµο των 
σχοινιών που συγκρατούν τα πανιά. Η κατασκευή τους δεν διαφέρει από εκείνη των 
ιστίων και για αυτό παρουσιάζονται µόνο γραφικά. 
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Τέλος σχεδιάζουµε τους ιµάντες συγκράτησης των ιστίων µεταξύ τους αλλά και µε 
τον κύριο κορµό. Η σχεδίαση γίνεται µε πλαίσια τα οποία περιβάλλουν τα ιστία και 
είναι σχετικά απλή. Η µέθοδος σχεδιασής τους έχει περιγραφεί πλήρως σε 
προηγούµενες  κατασκευές. 
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3.2.8.B2. Κατασκευή του πρωραίου  ιστίου (ακάτιος) της Τριήρους 
 
Η σχεδίαση του πρώραθεν βοηθητικού ιστίου δεν διαφέρει σε γενικές γραµµές από 
αυτή του κυρίως ιστίου που βρίσκεται στη µέση του σκάφους. 
 
Ο ακάτιος εδράζεται σε σταθερή βάση υπό κλίση. Η σχεδίαση του βασικού µέρους 
της βάσης στήριξης είναι όµοια µε αυτή του µεγάλου ιστίου και παρουσιάζεται µόνο 
γραφικά. 
 

 
 
Ακολουθεί η σχεδίαση των διαµηκών κεκλιµένων στηρίξεων.  
 
Οι τελευταίες συγκρατούν τον κορµό του ακάτιου και µέσω ενός ύλου του δίνουν την 
κατάλληλη κλίση. 
 
Για να κατασκευάσουµε τα κατακόρυφα ενισχυτικά που στηρίζουν τις διαµήκεις 
κεκλιµένες στηρίξεις, δηµιουργούµε ζεύγος σηµείων µε την εντολή Point και στη 
συνέχεια ζεύγος ευθειών κατά την z διεύθυνση µε την εντολή Line.  
 
Κατά τα γνωστά φέρουµε την µεταξύ τους επιφάνεια µε την εντολή Blend και 
ολοκληρώνουµε την σχεδιασή τους δίνοντας τους το κατάλληλο πάχος µε την εντολή 
Extrude. 
 
 



 156 

 
 
Χρησιµοποιούµε την άνω αριστερή ακµή της βάσης στηρίξεως και ευθύγραµµο 
τµήµα που έχουµε δηµιουργήσει στο κάτω µέρος της βάσης για να κατασκευάσουµε 
τη κεκλιµένη στήριξη µε χρήση των εντολών Blend και Extrude.  
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Στη συνέχεια επιλέγουµε την εντολή Rotate για να στρέψουµε το ενισχυτικό στην 
σωστή θέση. 
 
Insert → Operations →  Rotate → ok 
Εµφανίζεται το παράθυρο Rotate  Definition 
 
Definition Mode → Axis-Angle  
Element → κλίκ στο κεκλιµένο ενισχυτικό 
Axis → κλίκ στην κάτω εγκάρσια ακµή του ενισχυτικού 
Angle  → µε πατηµένο το δεξί κλίκ στρέφουµε στην σωστή 
θέση έδρασης του κεκλιµένου ενισχυτικού 

 
 

 
 
 
Με χρήση της εντολής Split αφαιρούµε το τµήµα του ενισχυτικού που εισέρχεται στο 
εσωτερικό της βάσης και έπειτα µε την εντολή Symmetry φέρουµε το συµµετρικό 
του. 
 
Τέλος σχεδιάζουµε το ύλο συγκράτησης του ακατίου µε την γνωστή µέθοδο και η 
βαση στήριξης ολοκληρώθηκε. 
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Η σχεδίαση του κυρίως ιστίου του ακάτιου, καθώς και των εγκαρσίων µικρότερων 
ιστίων στήριξης των πανιών, γίνεται ακριβώς µε το τρόπο που περιγράψαµε 
παραπάνω. Ακολουθεί γραφική παρουσίαση της σχεδίασης των ιστίων της Τριήρους. 
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3.2.9 ΣΥΣΤΗΜΑ ΠΗ∆ΑΛΙΟΥΧΗΣΗΣ 
 
 
 
Οι Τριήρεις ήταν σχετικά ελαφριές και ευέλικτες κατασκευές.  
 
Η πηδαλιουχησή τους γινόταν µε ένα ζεύγος χειροκίνητων πηδαλίων που βρίσκονταν 
στη πρύµνη  δεξιά και αριστερά του σκάφους.  
 
Τα πηδάλια χειρίζονταν από τον πηδαλιούχο που βρισκόταν ακριβώς µπροστά από 
τον Τριήραρχο που έιχε  την γενική εποπτεία του σκάφους.  
 
Τα πηδάλια είχαν την δυνατότητα κίνησης προς δύο κατευθύνσεις. Κατά το διάµηκες 
στον x άξονα και σε περιστροφή γύρω από τον αξονά τους στην y διεύθυνση. Η 
κίνηση στον x άξονα τους έπετρεπε την διεισδυσή τους ή όχι στο νερό και η 
περιστροφή τους την άσκηση αντίστασης άρα και στροφής του σκάφους. 
 
Να σηµειωθεί ότι για πολύ µέγάλες γωνίες στροφής της Τριήρους τα πηδάλια έπαιζαν 
βοηθητικό ρόλο έφοσον αυτό ήταν εύκολο να πραγµατοποιηθεί µε µεµονωµένη 
χρήση των αριστερών ή δεξιών σειρών κουπιών. 
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3.2.9.B1. Κατασκευή του κύριου άξονα των πηδαλίων 
 
Για να µπορέσουµε να περιγράψουµε την κατασκευή του πηδαλίου της Τριήρους,  θα 
εµφανίσουµε  µε την εντολή  Hide/Show  την κάτω βάση στήριξης του, η σχεδίαση 
της οποίας θα περιγραφεί παρακάτω στο κεφάλαιο δευτερεύουσες κατασκευαστικές 
λεπτοµέρειες. 
 

 
 

Στις εσωτερικές ακµές της βάσης στηρίξεως δηµιουργούµε αντιδιαµετρικό ζεύγος 
σηµείων µε διπλή χρήση της εντολής Point. Χαράσουµε  την ευθεία που ορίζουν µε 
την εντολή Line.  
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Επαναλαµβάνουµε την διαδικασία για το άνω σηµείο στήριξης του πηδαλίου στο 
υπερυψωµένο κατάστρωµα. 
 

 
 
∆ηµιουργούµε τα σηµεία των µέσων των ευθειών και φέρουµε την µεταξύ τους 
ευθεία η οποία τελικά διέρχεται από το µέσο της άνω και κάτω στηρίξεως του 
πηδαλίου. 
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Στη συνέχεια χρησιµοποιούµε την εντολή Cylinder  µία φορά για να κατασκευάσουµε 
το κύριο στέλεχος του άξονα του πηδαλίου και άλλη µία, µε µεγαλύτερη διάµετρο, 
για να κατασκευάσουµε το εξωτερικό µεταλλικό περίβληµα του άξονα που ακουµπά 
στη κάτω βάση στηρίξεως. 
 

 
 
Επαναλαµβάνουµε το ίδιο για την επάνω στήριξη στο υπερυψωµένο κατάστρωµα.  
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Κλείνουµε τις ανοιχτές επιφάνειες των άκρων των κυλίνδρων µε την εντολή Fill . 
Επιλέγουµε την εντολή Plane και ορίζουµε επίπεδο στην άνω κυκλική επιφάνεια του 
στελέχους του πηδαλίου. Με την εντολή Positioned  Sketch χαράσουµε στο 
προηγούµενο επίπεδο το περίγραµµα του στελέχους συγκράτησης του εγκαρσίου 
τµήµατος του πηδαλίου. 
 

 
 
Κλείνουµε την επιφάνεια του περιγράµµατος µε την εντολή Fill  και κατασκευάζουµε 
το στέλεχος µε την εντολή Extrude. 
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3.2.9.B2. Κατασκευή του χειροκίνητου εγκάρσιου τµήµατος του 
πηδαλίου 
 
Με  επίπεδο σχεδίασης αυτό που δηµιουργήσαµε το στέλεχος συγκράτησης του 
εγκαρσίου τµήµατος του πηδαλίου, χαράσουµε το µισό περίγραµµα του χειροκίνητου 
τµήµατος του πηδαλίου.  
 

 
 
Φέρουµε ευθεία που ενώνει τα άκρα του περιγράµµατος µε την εντολή Line και η 
οποία στην συνέχεια θα χρησιµοποιηθεί ως άξονας συµµετρίας. 
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Θα κατασκευάσουµε το εγκάρσιο χειροκίνητο τµήµα του πηδαλίου µε την εντολή 
Revolve ως εξής : 
 
Insert → Surfaces →  Revolve → ok 
Εµφανίζεται το παράθυρο Revolve  Definition 
 
Profile → κλίκ στο περίγραµµα που σχεδιάσαµε 
Revolution Axis → κλίκ στην ευθεία που ενώνει τα άκρα του 
περιγράµµατος 
Angle 1 → 360 µοίρες  
Angle 2 → 0 µοίρες 
ok 

 

 
  
Με την ίδια διαδικασία κατασκευάζουµε και την χειρολαβή του εγκάρσιου τµήµατος 
του πηδαλίου, την οποία χρησιµοποιεί ο πηδαλιούχος για να καθοδηγεί τα πηδάλια 
όπως επιθυµεί.  
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Και έτσι η κατασκευή του εγκαρσίου χειροκίνητου τµήµατος του πηδαλίου 
ολοκληρώθηκε. 
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3.2.9.B3. Κατασκευή του κάτω άκρου του στελέχους του πηδαλίου 
 
Τα πηδάλια της Τριήρους έχουν την µορφή µεγάλων κουπιών. Το κάτω άκρο του 
στελέχους του πηδαλίου αποτελείται από µία επίπεδη επιφάνεια συγκεκριµένης 
υδροδυναµικής διαµόρφωσης η οποία όταν στρέφεται κάθετα στην ροή του νερού 
δηµιουργεί αντίσταση ικανή να αλλάξει την πορεία του σκάφους. 
 
Αρχικά  σχεδιάζουµε την κυλινδρική προέκταση του κύριου στελέχους του πηδαλίου 
πάνω στο οποίο εδράζεται το κάτω άκρο. Επειδή η διάµετρος του άξονα µικραίνει 
όσο αυτός πλησιάζει στο κάτω άκρο, για το λόγο αυτό φέρουµε κύκλο µε την εντολή 
Circle στο κάτω άκρο του άξονα και στη συνέχεια µε την εντολή Blend χαράσουµε 
την επιφάνεια µεταξύ του κεντρικού στέλεχους και του κάτω µέρους του άξονα. 
 

 
 
Στη συνέχεια σχεδιάζουµε την επιφάνεια του κάτω άκρου ως εξής : 
 
∆ηµιουργούµε επίπεδο εφαπτοµενικό στο κάτω κυκλικό άκρο του άξονα µε την 
εντολή Plane. 
 
Σε αυτό το επίπεδο σχεδιάζουµε ευθεία κάθετη στο στέλεχος του άξονα µε την 
εντολή Sketch Positioned. 
 
Προεκτείνουµε την ευθεία κατά την διεύθυνση του επιπεδου µε την εντολή Extrude. 
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∆ηµιουργούµε νέο επίπεδο εφαπτοµενικό στην επιφάνεια που σχεδιάσαµε µε την 
εντολή Plane. 
 
Σχεδιάζουµε το προφίλ του κάτω άκρου και προεκτείνουµε κατά την διεύθυνση του 
επιπέδου (εντολές Sketch Positioned και Extrude ). 
 
Τέλος κόβουµε την επιφάνεια µε την εντολή Split. 
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Η κατασκευή του συστήµατος πηδαλιούχησης ολοκληρώνεται µε την µεταλλική 
ενίσχυση στο κάτω µέρος του άκρου και τις υλώσεις. 
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3.2.10 ΚΟΥΠΙΑ 
 
 
Η Τριήρης έφερε τρείς σειρές κωπηλατών (άρα και κουπιών) οι οποίοι ανάλογα µε 
την θέση τους στο ύψος του πλοίου είχαν και τρείς διαφορετικές ονοµασίες : 
θρανίτες, ζυγίτες και θαλαµίτες. 
 
Κάθε σειρά κουπιών είχε διαφορετικό γεωµετρικό σχήµα στο κάτω άκρο του 
στελέχους του κουπιού µε σκοπό την αποδοτικότερη κωπηλάτηση. Το  διαφορετικό 
σχήµα είχε να κάνει κυρίως µε την ταχύτητα εισόδου-εξόδου των κουπιών στο νερό. 
 
Έτσι οι θαλαµίτες που η θέση τους ήταν πιο κοντά στην ίσαλο επιφάνεια είχαν 
κουπιά µε κάτω άκρο στενό και µακρύ, οι ζυγίτες κουπιά µε κάτω άκρο µεγαλύτερου 
πλάτους και µικρότερου µήκους από των θαλαµιτών και οι θρανίτες κουπιά µε κάτω 
άκρο αρκετά πιο πλατύ και πιο κοντό από τους θαλαµίτες και τους ζυγίτες. 
  
Τα κουπιά και των τριών σειρών είχαν το ίδιο µήκος. Οι τρείς σειρές κουπιών δεξιά 
και αριστερά του σκάφους ήταν το κύριο µέσο πρόωσης της Τριήρους. 
 
Η σχεδίαση των κουπιών της Τριήρους στηρίχτηκε στο κατασκευαστικό σχέδιο των 
κουπιών που παρουσιάζεται στο 2ο κεφάλαιο. Η πληροφορία που έχουµε αναφέρεται 
µόνο στο µήκος των κουπιών και συνεπώς τα κάτω άκρα της κάθε σειράς 
σχεδιάζονται µε αναλογία κλίµακας. 
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3.2.10.B1. Κατασκευή της 1ης σειράς κουπιών των θαλαµιτών 
 
Αρχικά επιλέγουµε την εντολή Sketch και σχεδιάζουµε το µισό περίγραµµα του κάτω 
άκρου του στελέχους του κουπιού. 
 

 
 
Και στη συνέχεια µε την εντολή Plane φέρουµε επίπεδο κάθετο σε εκείνο του 
περιγράµµατος που µόλις σχεδιάσαµε. 
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Κατόπιν χρησιµοποιούµε την εντολή Symmetry για να χαράξουµε το συµµετρικό 
του περιγράµµατος του κάτω άκρου του κουπιού. 
 

 
 
Κλείνουµε το περίγραµµα της κατόψεως του κάτω άκρου µε την εντολή Line. 
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Με χρήση της εντολής Fill σχεδιάζουµε την επιφάνεια που περικλείεται από το 
περίγραµµα και δίνουµε το κατάλληλο πάχος µε την εντολή Extrude. 
 

 
 
Συνεχίζοντας δηµιουργούµε σηµείο στο µέσο της άνω επιφάνειας του κάτω άκρου µε 
την εντολή Point και φέρουµε ευθεία µε την εντολή Line µε µήκος ίσο µε αυτό του 
κυρίου στελέχους του κουπιού. 
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Στη συνέχεια κατασκευάζουµε κύκλους στα άκρα του ευθύγραµµου τµήµατος µε την 
εντολή Circle µε διάµετρο ίση µε την διάµετρο του κύριου στελέχους του κουπιού. 
 

 
 
Και φέρουµε την επιφάνεια του κυρίου στελέχους του κουπιού µε την εντολή Blend 
και και καµπυλώνουµε τις ακµές του κάτω άκρου µε την εντολή Edge Fillet. 
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Για να κατασκευάσουµε το άνω άκρο του κουπιού επιλέγουµε νέο Sketch, στο ίδιο 
επίπεδο  που σχεδιάσαµε το κάτω άκρο, και φέρουµε κατά τον ίδιο τρόπο όπως 
προηγουµένως το µισό περίγραµµα. 
 

 
 
Όπως  και στο κάτω άκρο χαράσουµε το συµµετρικό, γεµίζουµε την επιφάνεια και 
δίνουµε το κατάλληλο πάχος. 
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Στο µέσο της  επιφάνειας του άνω άκρου του κουπιού δηµιουργούµε σηµείο µε την 
εντολή Point και στην συνέχεια κύκλο µε την εντολή Circle που έχει κέντρο το 
προηγούµενο σηµείο και εφάπτεται της επιφάνειας. 
 

 
 
Στη συνέχεια γεµίζουµε την επιφάνεια του κύκλου µε την εντολή Fill  και 
κατασκευάζουµε την χειρολαβή του κουπιού µε την εντολή Extrude. 
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Η κατάλληλη καµπυλότητα στο άκρο της χειρολαβής επιτυγχάνεται  µε χρήση της 
εντολής Edge Fillet. 
 

 
 
Κατόπιν ενώνουµε τα επιµέρους τµήµατα του στελέχους του κουπιού µε την εντολή 
Join. 
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Θέλωντας να τοποθετήσουµε στις σωστές θέσεις τα κουπιά της 1ης σειράς των 
θαλαµιτών κάνουµε συνδυασµό των εντολών Translate και Rotate µε γνωστές 
µεθόδους που έχουν περιγραφεί σε προηγούµενα κεφάλαια. 
 

 
 
Και έτσι ολοκληρώθηκε η κατασκευή της 1ης σειράς των κουπιών των θαλαµιτών.  
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3.2.10.B2. Κατασκευή της 2ης σειράς κουπιών των ζυγιτών και της 3ης 
σειράς κουπιών των θρανιτών 
 
Η διαδικασία σχεδίασης και κατασκευής της 2ης και 3ης σειράς κουπιών δεν διαφέρει 
από την διαδικασία της 1ης σειράς κουπιών παρά µόνο στην σχεδίαση του 
περιγράµµατος των κάτω άκρων των κουπιών.  
 
Για λόγους συντοµίας και για το γεγονός ότι δεν παρατηρείται κανένα 
κατασκευαστικό ενδιαφέρον θα παρουσιαστούν µόνο γραφικά της 2ης σειράς : 
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και τέλος της  3ης σειράς κουπιών : 
 

 
 
 

 
 
 
 
 



 182 

3.2.11 ∆ΕΥΤΕΡΕΥΟΥΣΕΣ ΚΑΤΑΣΚΕΥΑΣΤΙΚΕΣ 
ΛΕΠΤΟΜΕΡΕΙΕΣ 

 
 
3.2.11.B1. Κατασκευή της σκάλας που οδηγεί στο υπερυψωµένο 
κατάστρωµα 
 
Η κατασκευή της σκάλας που οδηγεί στο υπερυψωµένο κατάστρωµα είναι µια 
εύκολη διαδικασία. 
 
 Αρχικά σχεδιάζουµε ένα κατακόρυφο ενισχυτικό µε τις ίδιες µεθόδους που 
περιγράφηκαν σε προηγούµενα κεφάλαια. 
 
 Στη συνέχεια το στρέφουµε µε την εντολή Rotate και κόβουµε την άνω επιφανειά 
του µε επιφάνεια που προκύπτει από την ακµή του υπερυψωµένου καταστρώµατος µε 
την εντολή Split. 
 

 
 
Επαναλαµβάνουµε για την κάτω επιφάνεια του ενισχυτικού χρησιµοποιώντας ως 
επίπεδο τοµής το διάδροµο του 2ου καταστρώµατος.  
 
και κλείνουµε τις επιφάνειες του ενισχυτικού στα σηµεία τοµής µε την εντολή Fill . 
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Επιλέγουµε την εντολή Translate για να κατασκευάσουµε ενισχυτικό όµοιο µε το 
προηγούµενο το οποίο µεταφέρεται κατά την y διεύθυνση σε µήκος ίσο µε το πλάτος 
της σκάλας. 
 

 
 
Και µε αυτό τον τρόπο κατασκευάσαµε το αριστερό και δεξί στήριγµα της σκάλας. 
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Συνεχίζοντας επιλέγουµε την εντολή Line και φέρουµε ευθεία η οποία ενώνει τις δύο 
εσωτερικές ακµές των στηριγµάτων.  
 

 
 
Με προφίλ την προηγούµενη ευθεία φέρουµε επιφάνεια κατά την x διεύθυνση µε την 
εντολή Extrude. 
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Χρησιµοποιούµε  την εντολή Extrude για να δώσουµε το απαραίτητο πάχος στο 
σκαλοπάτι.  
 

 
 
Κατασκευάζουµε τα υπόλοιπα σκαλοπάτια µε πολλαπλή χρήση της εντολής 
Translate επιλέγοντας σαν διεύθυνση την εσωτερική ακµή του στηρίγµατος της 
σκάλας. 
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3.2.11.B2. Κατασκευή του άνω εξωτερικού διαµήκους ενισχυτικού 
της γάστρας. 
 
Το άνω εξωτερικό διαµήκες ενισχυτικό χρησιµοποιείται για την ενίσχυση της 
αντοχής της συνολικής κατασκευής της γάστρας της Τριήρους.  
 
Επίσης αποτελεί την βάση στηρίξεως των κατακόρυφων εγκάρσιων ενισχυτικών του 
υπερυψωµένου καταστρώµατος. 
 
Για να σχεδιάσουµε το άνω εξωτερικό διαµήκες ενισχυτικό χρησιµοποιούµε την 
εντολή Spline και φέρνουµε καµπύλη η οποία παρεµβάλλει τα σηµεία τοµής του 
εξωτερικού κελύφους της γάστρας µε τα κατακόρυφα ενισχυτικά του υπερυψωµένου 
καταστρώµατος. 
 

 
 
Εργαζόµαστε µε τον συγκεκριµένο τρόπο για όλο το µήκος της γάστρας που έχει 
σηµεία τοµής µε τα κατακόρυφα εγκάρσια ενισχυτικά του υπερυψωµένου 
καταστρώµατος. 
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Στη συνέχεια µε χρήση της εντολής Extrude φέρουµε την επιφάνεια του διαµήκους 
ενισχυτικού προεκτείνοντας ως την άνω ακµή του κατακόρυφου εγκαρσίου 
ενισχυτικού του καταστρώµατος. 
 

 
 
∆ίδουµε το κατάλληλο πάχος στο διαµήκες ενισχυτικό µε την εντολή Extrude 
προεκτείνοντας κατά την y διεύθυνση. 
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Το εξωτερικό διαµήκες ενισχυτικό εκτείνεται σε όλο το µήκος της γάστρας. Για το 
τµήµα της γάστρας που δεν έχουµε σηµεία τοµής µε τα κατακόρυφα ενισχυτικά 
εργαζόµαστε ως εξής : 
 
Επιλέγουµε την εντολή Point και δηµιουργούµε σηµεία πάνω στο εξωτερικό µέρος 
της γάστρας. Με την εντολή Spline παρεµβάλλουµε τα σηµεία και χρησιµοποιούµε 
όπως πρίν δύο φορές την εντολή Extrude για να κατασκευάσουµε το υπόλοιπο 
τµήµα του εξωτερικού διάµηκους ενισχυτικού. 
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3.2.11.B3. Κατασκευή των εγκαρσίων ενισχυτικών του 
υπερυψωµένου καταστρώµατος 
 
Σε αυτό το σηµείο θα κατασκευάσουµε τις εγκάρσιες ενισχύσεις του υπερυψωµένου 
καταστρώµατος οι οποίες στηρίζουν το υπερυψωµένο κατάστρωµα και ενισχύουν την 
αντοχή της συνολικής κατασκευής της Τριήρους. 
 
Επιλέγουµε αρχικά την εντολή Line και χαράσουµε ευθεία η οποία ενώνει τα 
εσωτερικά σηµεία των ακµών των κατακόρυφων ενισχυτικών του υπερυψωµένου 
καταστρώµατος. 
 

 
 
Στη συνέχεια µε διπλή χρήση  της εντολής Extrude φέρουµε την επιφάνεια του 
εγκάρσιου ενισχυτικού στην z  διεύθυνση  και δίδουµε το απαραίτητο πάχος στην x 
διεύθυνση. 
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Κατά τον ίδιο τρόπο εργαζόµαστε για να κατασκευάσουµε την άνω στήριξη του 
κατακόρυφου ενισχυτικού µε το εγκάρσιο ενισχυτικό του υπερυψωµένου 
καταστρώµατος. 
 

 
 
Συνεχίζουµε την ίδια διαδικασία και κατασκευάζουµε την κάτω στήριξη του 
κατακόρυφου ενισχυτικού µε το εγκάρσιο ενισχυτικό των θέσεων του 2ου 
καταστρώµατος. 
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Επαναλαµβάνουµε την διαδικασία κατασκευής των εγκαρσίων ενισχυτικών και των 
στηριξεών τους για όλο το µήκος του υπερυψωµένου καταστρώµατος. 
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3.2.11.B4. Κατασκευή γωνιακών ενισχύσεων (µπρακέτα) του 2ου 
καταστρώµατος 
 
Αρχικά δηµιουργούµε επίπεδο εφαπτοµενικό στην άνω επιφάνεια του διαµήκους 
ενισχυτικού του 2ου καταστρώµατος. Στη συνέχεια επιλέγουµε την εντολή Positioned 
Sketch και χαράσουµε το περίγραµµα της κατόψεως του γωνιακού ενισχυτικού. 
 

 
 
Χρησιµοποιούµε την εντολή Fill  για να σχηµατίσουµε την επιφάνεια που περικλείει 
το περίγραµµα της κατόψεως και έπειτα την εντολή Extrude για κατασκευάσουµε 
την γωνιακή ενίσχυση-στήριξη. 
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Η διαδικασία επαναλαµβάνεται µέχρι να κατασκευαστούν όλες οι γωνιακές 
ενισχύσεις- στηρίξεις των εγκάρσιών ενισχυτικών µε τα διαµήκη ενισχυτικά του 
δευτέρου καταστρώµατος. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 194 

 
3.2.11.B5. Κατασκευή του διαµήκους ενισχυτικού στηρίξεως των 
κουπιών του 3ου καταστρώµατος και της κάτω βάσης στηρίξεως του 
πηδαλίου 
 
Αρχικά επιλέγουµε την εντολή 3D Curve Offset και φέρουµε την  καµπύλη της 
ακµής του κυρίου καταστρώµατος σε κατάλληλη απόσταση κατά την y διεύθυνση. 
 

 
 
και χρησιµοποιούµε την εντολή Extrude και σχεδιάζουµε επιφάνεια µε προέκταση 
κατά τον z άξονα. 
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Στη συνέχεια µε προέκταση κατά την y διεύθυνση µε την εντολή Extrude δίδουµε 
πάχος στο διαµήκες ενισχυτικό στήριξης των κουπιών του 3ου καταστρώµατος. 
 

 
 
Αφαιρούµε µε την εντολή Split το πρυµναίο τµήµα του ενισχυτικού που δεν 
χρειάζεται. 
 

 
 



 196 

Επιλέγουµε xy επίπεδο σχεδίασης και την εντολή Sketch. Χαράσουµε κύκλο στο 
επίπεδο µε την εντολή Circle. 
 

 
 
Χρησιµοποιούµε την εντολή Extrude στην z διεύθυνση για να φέρουµε  κύλινδρο. 
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Επιλέγουµε xz επίπεδο σχεδίασης και την εντολή Sketch. Χαράσουµε το περίγραµµα 
του εγκάρσιου ενισχυτικού στήριξης της βάσεως. 
 

 
 
Κατασκευάζουµε το ενισχυτικό στήριξης µε χρήση της εντολής Extrude. 
 

 
 
Στη συνέχεια κατασκεύαζουµε τους µεταλλικούς κυλίνδρους που εδράζονται στην 
άνω και κάτω µέρος του κυλίνδρου της βάσης στηρίξεως του πηδαλίου. 
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Σε επίπεδο xy, µε την εντολή Sketch, σχεδιάζουµε νέο κύκλο οµόκεντρο µε την 
κύκλο της βάσης του κυλίνδρου στήριξης. 
 

 
 
∆ίνουµε το απαραίτητο ύψος µε την εντολή Extrude κατά την z διεύθυνση. 
 

 
 
Κλείνουµε την άνω και κάτω επιφάνεια του µεταλλικού κυλίνδρου µε την εντολή 
Fill . 
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Με την εντολή Line σχεδιάζουµε την κάτω ακµή του µεταλλικού σηµείου έδρασης 
της βάσης στηρίξεως του πηδαλίου.  
 

 
 
Με προφίλ την ευθεία που σχεδιάσαµε και διπλή χρήση της εντολής Extrude 
σχηµατίζουµε το κάτω τµήµα της επιφάνειας έδρασης. 
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Με το ίδιο τρόπο εργαζόµαστε και κατασκευάζουµε την πλαϊνή στήριξη της 
επιφάνειας εδράσεως της βάσης του πηδαλίου. 
 

 
 
Επαναλαµβάνουµε το ίδιο για την κατασκευή της συµµετρική της. 
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Με προέκταση των πλαϊνών στηρίξεων στη z διεύθυνση και τη δηµιουργία του 
εγκάρσιου πύρου ασφάλισης όπως και η κατασκευή του ενισχυτικού στήριξης, 
ολοκληρώνουµε την βάση στηρίξεως του πηδαλίου. 
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3.2.11.B6. Κατασκευή των στηριγµάτων της 3ης σειράς κουπιών 
 
Αρχικά θα κατασκευάσουµε τις κατακόρυφες ενισχύσεις που εδράζονται πάνω στο 
διαµήκες ενισχυτικό στήριξης των κουπιών του 3ου καταστρώµατος. 
 
Στη συνέχεια δηµιουργούµε σηµεία µε την εντολή Point επί της εξωτερικής  ακµής 
του διαµήκους ενισχυτικού στήριξης των κουπιών του 3ου καταστρώµατος τα οποία 
απέχουν µεταξύ τους απόσταση ίση µε το πλάτος του κατακόρυφου ενισχυτικού που 
θέλουµε να κατασκευάσουµε. 
 
Φέρουµε  ευθείες από τα σηµεία µε την εντολή Line κατά τον z άξονα. 
 

 
 
Επιλέγουµε την εντολή Blend και σχηµατίζουµε την µεταξύ τους επιφάνεια. 
 
 Κατασκευάζουµε τα κατακόρυφα ενισχυτικά µε την εντολή Extrude προεκτείνοντας 
κατά την y διεύθυνση.  
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Επαναλαµβάνουµε την ίδια διαδικασία για όλες τις κατακόρυφες ενισχύσεις του 
διαµήκους ενισχυτικού της στήριξης των κουπιών του 3ου καταστρώµατος. 
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Με την εντολή Spline χαράσουµε καµπύλη η οποία παρεµβάλλει τα σηµεία των 
ακµών των κατακόρυφων ενισχυτικών. 
 

 
 
Χρησιµοποιούµε την εντολή Extrude για να φέρουµε  επιφάνεια στο xy επίπεδο και 
στην συνέχεια κατασκευάζουµε το διαµήκες ενισχυτικό (κάγκελο) µε προέκταση 
κατά την z διεύθυνση. 
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Η σχεδίαση των στηριγµάτων των κουπιών του 3ου καταστρώµατος δεν διαφέρει από 
την σχεδίαση των στηριγµάτων των άλλων δύο καταστρωµάτων και για αυτό για 
λόγους συντοµίας παρουσιάζονται µόνο γραφικά. 
 

 
 
Εµφανίζουµε την 3η σειρά κουπιών µε την εντολή Hide/Show. 
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3.2.11.B7. Κατασκευή των στηριγµάτων των ποδιών των 
κωπηλατών. 
 
Σε αυτό το σηµείο θα περιγράψουµε την σχεδίαση των στηριγµάτων (κόντρες) των 
ποδιών των κωπηλατών. 
 
 Αυτά ήταν απαραίτητα για την µέγιστη απόδοση και συντονισµό των κωπηλατών. 
            
Κατασκευαστικές λεπτοµέρειες των στηριγµάτων δεν υπάρχουν και συνεπώς η 
σχεδίαση θα στηριχθεί αποκλειστικά σε φωτογραφικό υλικό. 
 
Επίλεγουµε xz επίπεδο σχεδίασης και χρησιµοποιούµε την εντολή Sketch για να 
χαράξουµε το περίγραµµα της πλάγιας όψης του στηρίγµατος των ποδιών.               
 

 
 
Φέρουµε την επιφάνεια που περικλείει το περίγραµµα µε την εντολή Fill και 
κατασκευάζουµε την πλαϊνή βάση του στηρίγµατος των ποδιών µε την εντολή 
Extrude. 
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και µε την εντολή Translate κατασκευάζουµε την συµµετρική της. 
 

 
 
Στη συνέχεια χρησιµοποιούµε τις κάτω ακµές των πλαϊνών βάσεων για να 
κατασκευάσουµε τα σηµεία στήριξης των ποδιών µε διπλή χρήση της εντολής 
Extrude. 
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Κατόπιν επιλέγουµε την εντολή Sketch Positioned και δηµιουργούµε σηµεία πάνω 
στην επιφάνεια στήριξης των ποδιών. 
 
Σχεδιάζουµε την ευθεία που ορίζουν τα σηµεία µε την εντολή Line. 
 
Χαράσουµε ευθεία σε κάθετη διεύθυνση  στο µέσο της προηγούµενης ευθείας µε την 
εντολή Line. 
 
∆ηµιουργούµε σηµείο επί της κάθετης ευθείας µε την εντολή Point. 
 
Φέρουµε καµπύλη η οποία διέρχεται από τα ακραία σηµεία της ευθείας που 
εφάπτεται στην επιφάνεια στήριξης και το σηµείο που δηµιουργήσαµε στην κάθετη 
ευθεία µε την  εντολή Spline. 
 
 

 
 
Με προφίλ την καµπύλη που χαράξαµε, χρησιµοποιούµε την εντολή Extrude για να 
κατασκευάσουµε την επιφάνεια στήριξης των πελµάτων των κωπηλατών. 
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Με την εντολή Symmetry και επίπεδο συµµετρίας στην µέση της βάσης των ποδιών 
κατασκευάζουµε την συµµετρική στήριξη πέλµατος. 
 
Στην συνέχεια επιλέγουµε την εντολή Translate ώστε να µεταφέρουµε την βάση 
στήριξης των ποδιών των κωπηλατών στη σωστή διαµήκη θέση. 
 
Τέλος κατασκευάζουµε τον ύλο συγκράτησης της βάσεως µε τις γνωστές µεθόδους. 
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Επαναλαµβάνουµε την ίδια διαδικασία που µόλις περιγράψαµε και για τις τρείς 
σειρές κωπηλατών στα αντίστοιχα καταστρώµατα. 
 

 
 
 

 
 
 



 211 

3.2.11.B8. Κατασκευή της θέσεως του Τριήραρχου. 
 
Ο Τριήραρχος υποχρεωνόνταν στην επάνδρωση του σκάφους µε κατάλληλο πλήρωµα 
για την αναγκαία συντήρησή του. ∆ιατηρούσε την διοίκηση της Τριήρους καθ’ όλο 
το διάστηµα της Τριηραρχίας του. 
 
Η θέση του Τριήραρχου στο σκάφος βρισκόταν επί του κυρίου καταστρώµατος στην 
πρύµνη του σκάφους, γεγονός που του επέτρεπε την γενική εποπτεία του σκάφους. 
 
Η σχεδίαση θα στηριχθεί σε φωτογραφικό υλικό που συλλέξαµε από την επισκεψή 
µας στην µαρίνα Φλοίσβου όπου υπάρχει αντίγραφο της Τριήρους. 
 
Χρησιµοποιούµε την πρυµναία ακµή του διαµορφωµένου υπερυψωµένου 
καταστρώµατος για να κατασκευάσουµε την βάση στήριξης της θέσεως του 
Τριήραρχου. 
 
Επιλέγουµε την εντολή Extrude και προεκτείνουµε κατά την x διεύθυνση. 
 

 
 
Στη συνέχεια επιλέγουµε την σχηµατισµένη επιφάνεια και προεκτείνουµε κατά την z 
διεύθυνση µε χρήση της εντολής Extrude. 
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Στο πρυµναίο τµήµα του παραλληλογράµµου σχεδιάζουµε Sketch µε σκοπό την 
διαµόρφωση του πίσω µέρους του καθίσµατος. 
 

 
 
Σχηµατίζουµε την επιφάνεια του περιγράµµατος µε την εντολή Extrude στην x 
διεύθυνση και αφαιρούµε τµήµα της θέσεως µε την εντολή Split. 
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Επιλέγουµε νέο Sketch σε xz επίπεδο ώστε να διαµορφώσουµε την πλάγια όψη της 
θέσεως του Τριήραρχου. 
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Όπως προηγουµένως, φέρουµε  επιφάνεια µε την εντολή Extrude µε προέκταση κατά 
την y διεύθυνση 
 

 
 
και αφαιρούµε το πάνω τµήµα της θέσεως µε χρήση της εντολής Split. 
 

 
 
Στη συνέχεια κατασκευάζουµε το εσωτερικό της θέσεως του Τριηράρχου.  
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Αρχικά µε την εντολή Blend σχεδιάζουµε κατακόρυφη επιφάνεια στο εσωτερικό της 
θέσεως 
 

 
 
και στη συνέχεια κατασκευάζουµε το κάθισµα του Τριήραρχου µε χρήση της εντολής 
Extrude και προέκταση κατά την x διεύθυνση.  
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Για την διαµόρφωση της πλάτης της θέσεως δηµιουργούµε Sketch  στο   yz  επίπεδο 
της πλάτης. 
Σχεδιάζουµε σηµείο το οποίο βρίσκεται στο µέσο της εξωτερικής ακµής της πλάτης 
και στο σωστό ύψος. 
Φέρουµε καµπύλη, µε την εντολή Spline, που παρεµβάλλει τα ακραία  σηµεία  της 
εξωτερικής ακµής της πλάτης της θέσεως και το άνω σηµείο που σχεδιάσαµε.  
 

 
 
Κατόπιν µε την εντολή Extrude προεκτείνουµε το προφίλ της πλάτης κατά την x 
διεύθυνση. 
 

 



 217 

Χρησιµοποιούµε την άνω και κάτω ακµή της πλάτης για να φέρουµε την µετaξύ τους 
επιφάνεια µε την εντολή Blend. 
 

 
 
Επαναλαµβάνουµε το ίδιο για το µπροστινό τµήµα της πλάτης και ολοκληρώνουµε 
την κατασκευή της θέσεως του Τριήραρχου. 
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3.2.12  “∆ΕΝ∆ΡΟ” ΣΧΕ∆ΙΑΣΗΣ 
 
Σε κάθε φάση της σχεδίασης δηµιουργήθηκαν υποκατάλογοι που συνθέτουν την δοµή 
του “δένδρου“ σχεδίασης / προδιαγραφών (specification tree) του τρισδιάστατου 
γεωµετρικού µοντέλου της Αθηναϊκής Τριήρους στο σύστηµα CAD / CATIA V5 και 
οι οποίοι παρατίθενται παρακάτω : 
 
-Τριήρης  

• Κατασκευή γάστρας 
• Πάχος γάστρας 
• Οπές κουπιών   
• Οπές κουπιών 2  
• Ανώτερα  εγκάρσια ενισχυτικά 
• Κατώτερα εγκάρσια ενισχυτικά 
• Μεσαία εγκάρσια ενισχυτικά 
• Ενισχυτικό κυρίου καταστρώµατος 
• Ανώτερα  διαµήκη ενισχυτικά 
• Κατώτερα διαµήκη ενισχυτικά 
• Μεσαία διαµήκη ενισχυτικά 
• Εγκάρσια ενισχυτικά των θέσεων της 1ης σειράς κωπηλατών 
• ∆ιαµήκεις ενισχύσεις – στηρίξεις των θέσεων της 1ης σειράς κωπηλατών 
• 1η σειρά θέσεων κωπηλάτησης 
• Στηρίγµατα 1ης σειράς κουπιών 
• Μεσαία εγκάρσια ενισχυτικά 1ου καταστρώµατος 
• Εγκάρσια ενισχυτικά των θέσεων της 2ης σειράς κωπηλατών 
• Στηρίγµατα 2ης σειράς κουπιών 
• Μεσαία εγκάρσια ενισχυτικά 2ου καταστρώµατος 
• Κεντρικός διάδροµος του 2ου καταστρώµατος 
• 2η σειρά θέσεων κωπηλάτησης 
• ∆ιάµηκες ενισχυτικό 2ου καταστρώµατος 
• Εγκάρσια ενισχυτικά – στηρίξεις του 3ου καταστρώµατος 
• ∆ιαµήκεις στηρίξεις των θέσεων του 3ου καταστρώµατος 
• Κατακόρυφα εγκάρσια ενισχυτικά του κυρίου καταστρώµατος 
• Υπερυψωµένο κατάστρωµα 
• Ανώτερο  εξωτερικό διάµηκες ενισχυτικό της γάστρας 
• Εγκάρσιες ενισχύσεις υπερυψωµένου καταστρώµατος 
• Γωνιακές ενισχύσεις ( µπρακέτα ) του 2ου καταστρώµατος   
• Κατώτερη βάση στήριξης του πηδαλίου – διάµηκες ενισχυτικό στήριξης 

των κουπιών 
• Κατασκευή – διαµόρφωση πρύµνης 
• Κάθισµα του Τριήραρχου 
• Κάγκελα – διαµόρφωση πλώρης 
• Κατώτερο διάµηκες εξωτερικό ενισχυτικό της γάστρας 
• ∆ιαµόρφωση πλώρης – σηµείο εµβολισµού 
• Σκάλα υπερυψωµένου καταστρώµατος 
• Ιστία 
• 1η σειρά κουπιών 
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• 2η σειρά κουπιών 
• 3η σειρά κουπιών 
• Σύστηµα πηδαλιούχησης 
• Στηρίγµατα ποδιών των κωπηλατών 
• Συµµετρική γάστρα 

    
      
     Σκοπός της δηµιουργίας των υποκαταλόγων στο “δένδρο” σχεδίασης είναι η 
κατάταξη των διαφόρων επιµέρους συστατικών τµηµάτων προς  γρήγορη επισκόπηση 
και ευκολότερη χρήση, εύρεση και διόρθωση / συµπλήρωση.  
     
      Να σηµειωθεί ότι κάθε υποκατάλογος που αποτελεί τµήµα του συνολικού 
γεωµετρικού µοντέλου περιέχει πολύ µεγάλο πλήθος ακολουθίας εντολών.  
      
    Στα δύο παρακάτω σχήµατα φαίνεται η δοµή του δένδρου σχεδίασης του 
συστήµατος CAD / CATIA V5 καθώς και η ακολουθία εντολών που περιλαµβάνει ο 
κάθε υποκατάλογος. 
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    Τέλος, ο υποκατάλογος “συµµετρική γάστρα” µε χρήση της εντολής Hide / Show 
µας επιτρέπει να αποκρύπτουµε  προσωρινά το µισό τµήµα της γάστρας και µε την 
βοήθεια της εντολής zoom ( in / out ) να µεγενθύνουµε επικεντρώνοντας σε όποια 
σχεδιαστική / κατασκευαστική λεπτοµέρεια επιθυµούµε. 
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3.3  ΦΩΤΟΓΡΑΦΙΕΣ - ΓΡΑΦΙΚΗ ΠΑΡΟΥΣΙΑΣΗ 
 
 
Σας παρουσιάσαµε προηγουµένως την αναλυτική σχεδίαση του γεωµετρικού 
µοντέλου της Αθηναϊκής Τριήρους. 
 
Στη προσπάθεια ακριβούς απεικόνισης των κατασκευαστικών λεπτοµερειών της 
Αθηναϊκής Τριήρους, ελήφθη σειρά φωτογραφιών.  
 
Το φωτογραφικό υλικό των οποίων παρατίθεται ούτως ώστε να είναι δυνατή η 
πιστότητα της πλήρους απεικόνισης του τρισδιάστατου µοντέλου µε αυτό του 
πραγµατικού. 
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3.3.1 ΦΩΤΟΓΡΑΦΙΕΣ 
 
3.3.1.1. Πανοραµική φωτογραφία της Τριήρους 
 

 
 

 



 223 

3.3.1.2. Πρωραίο τµήµα της Τριήρους 
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3.3.1.3. Πρυµναίο τµήµα της Τριήρους 
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3.3.1.4. Σκάλα υπερυψωµένου καταστρώµατος 
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3.3.1.5. Όψη πρυµναίου τµήµατος του υπερυψωµένου 
καταστρώµατος 
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3.3.1.6. Όψη πρωραίου τµήµατος του υπερυψωµένου 
καταστρώµατος 
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3.3.1.7. Βάση στήριξης του ακάτιου (µικρό ιστίο της Τριήρους) 
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3.3.1.8. Βάση στήριξης του µεγάλου ιστίου της Τριήρους 
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3.3.1.9. Θέσεις κωπηλατών 
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3.3.1.10. Βεντάλια ακροστολίου 
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3.3.2 ΓΡΑΦΙΚΗ ΠΑΡΟΥΣΙΑΣΗ 
 

 
3.3.2.1. Κάτοψη Τριήρους 
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3.3.2.2. Πλάγια όψη της  Τριήρους 
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3.3.2.3. Πλώρη της  Τριήρους 
 
 

 
 
 
3.3.2.4. Πρύµνη της  Τριήρους 
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ΒΙΒΛΙΟΓΡΑΦΙΚΕΣ ΑΝΑΦΟΡΕΣ 

 
 
 
 
1. THE ATHENIAN TRIREME 
     
The history and reconstruction of an ancient Greek warship 
    
 Second edition 
  
J.S.MORRISON, J.F.COATES and N.B.RANKOV 
 
 
2. Πηγές από το διαδίκτυο 
 

• http://wikipedia.org/ 
• http://www.hellenicnavy.gr/trihrhs.asp 
• http://www.geocities.com 
• http://www.trireme.gr 
• http://gym_platan.chan.sch.gr/pw/persianwars 
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ΕΠΙΛΟΓΟΣ 

 
Στα πλαίσια της παρούσης διπλωµατικής εργασίας κατεβλήθη κάθε προσπάθεια 
ακριβούς και λεπτοµερούς απεικόνισης, κατά το δυνατό,  τρισδιάστατου γεωµετρικού 
µοντέλου της Αθηναϊκής Τριήρους µε χρήση του προγράµµατος CAD : CATIA V5. 
Η σχεδίαση βασίστηκε σε ναυπηγικές γραµµές σχεδίασης και κατασκευαστικά σχέδια 
του συγγράµατος “ THE ATHENIAN TRIREME “  των J. S. MORRISON, J. F. 
COATES και N. B. RANKOV καθώς και σε φωτογραφικό υλικό που ελήφθη από 
επισκέψεις στην µαρίνα Φλοίσβου όπου βρίσκεται αντίγραφο σκάφους της Τριήρους. 
∆υστυχώς, ολοκληρωµένο πιστό αντίγραφο της Αθηναϊκής Τριήρους δεν έχει βρεθεί, 
παρά µόνο τµήµατα αυτής τα οποία συναρµολογήθηκαν και συµπληρώθηκαν κατ’ 
εκτίµηση των ερευνητών. Αυτός είναι και ο λόγος που οι ναυτικοί ερευνητές και οι 
αρχαιολόγοι δεν είναι απολύτως σίγουροι για τις κύριες διαστάσεις της Τριήρους 
οπότε και σε όλα τα συγγράµατα δίνουν κάποιο εύρος τιµών των κυρίων διαστασεών 
της.  Επίσης είναι γνωστό ότι τόσο το σηµείο εµβολισµού όσο και το ακροστόλιο της 
Τριήρους διέφερε από σκάφος σε σκάφος ανάλογα µε την τεχνοτροπία του ναυπηγού 
µελετητή. 
Λόγω των προηγούµενων παραµέτρων, στην περιγραφή των σταδίων κατασκευής του 
γεωµετρικού µοντέλου, σκοπίµως απεφεύχθει η αναφορά στις ακριβείς τιµές των 
διαστάσεων των κατασκευαστικών µερών της Τριήρους. Επίσης το πλήθος των 
πληροφοριών δεν ήταν αρκετό ώστε να είµαστε σίγουροι για τις ακριβείς διαστάσεις 
των επιµέρους κατασκευαστικών λεπτοµερειών. Συνεπώς χρησιµοποιήθηκαν 
διαστάσεις οι οποίες προέκυψαν από τα σχέδια των βασικών γραµµών, της µέσης 
τοµής και των κατασκευαστικών σχεδίων όπως αυτά παρουσιάζονται στο 
προαναφερθέν  σύγγραµα “ THE ATHENIAN TRIREME “. Στηριζόµενοι στα 
προηγούµενα σχέδια εξήχθησαν πληροφορίες για τα λοιπά επιµέρους 
κατασκευαστικά στοιχεία της Τριήρους εφαρµόζοντας την αναλογία κλίµακας. Ενώ 
για τµήµατα της κατασκευής που δεν υπήρχαν καθόλου πληροφορίες 
χρησιµοποιήθηκε φωτογραφικό υλικό και προσωπικές εκτιµήσεις  για την σχεδίαση 
τους. 
 
 

 


